
 

 
 
 

 

 
FOREST ECOSYSTEM SERVICES 

ASSESSMENT PILOT ACTION REPORT 
                                                                                                                                                                                       D.2.2.1 

 
 
 

 

                                                                                          RESPONSIBLE PARTNER: INRAE / PP4 
 
 
 
 
 
 
 
 
 

 
                                                                                                                                                                                   DISCLAIMER 

THIS DELIVERABLE D.2.2.1 (VERSION 1) WILL UNDERGO FURTHER REFINEMENT AND INTEGRATION UNTIL 
THE END OF THE FOREST ECOVALUE PROJECT. THE FINAL VERSION WILL REPLACE THIS ONE ON THE 

PROJECT WEBSITE AND WILL BE MADE AVAILABLE BY APRIL/MAY 2026. 



1 

D.2.2.1: FOREST ECOSYSTEM SERVICES ASSESSMENT PILOT ACTION REPORT 
 

 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Interreg Alpine Space Programme 21-27 

28/11/2025 

Document Version: 1 

 

Carbon neutral and resource sensitive Alpine region 

SO 2.2: Promoting the transition to a circular and resource efficient economy 

Forest EcoValue: 
Supporting multiple forest ecosystem services through new circular/green/bio 
markets and value chains 

 
Project ID: ASP0100005 



2 

D.2.2.1: FOREST ECOSYSTEM SERVICES ASSESSMENT PILOT ACTION REPORT 
 

List of the Forest EcoValue project partners 

PP1. Finpiemonte SpA – Regional financial and development agency / Coordinator [FINPIE] PP2.
 Lombardy Foundation for the Environment – Fondazione Lombardia per l’Ambiente [FLA] 
PP4. National Research Institute for Agriculture, Food and Environment – Institut National de Recherche 

pour l'Agriculture, l'Alimentation et l'Environnement [INRAE] 

PP5. Slovenia Forest Service – Zavod za Gozdove Slovenije [ZGS] 
PP6. Institute for Environmental Planning and Spatial Development GmbH & Co. KG – Institut für 

Umweltplanung und Raumentwicklung GmbH & Co. KG [Ifuplan] 
PP7. Lombardy Green Chemistry Association – Cluster Lombardo della Chimica Verde [LGCA] 
PP8. University of Graz, Institute of Environmental Systems Sciences [UNIGRAZ] 
PP9. Regional Centre for Forest Property Auvergne-Rhône-Alpes – Centre Régional de la Propriété 

Forestiére [CNPF] 
PP10. The French National Forest Office – Office National des Forêts [ONF] 
PP11. Hozcluster Steiermark – Woodcluster Styria [HCS] 

 

Document information 
 

Work package: WP2 Testing an economic approach for managing FES in a network of 
Living Labs (LLs) 

WP lead: PP6 

Activity: A.2.2. 

Authors: Deliverable edited by the Forest EcoValue project partners under the 

supervision of WP leaders 

Main contributor(s): Frederic Berger (PP4) 

Reviewers: Reviewed by PP6 

Document version: 1 

Due date (month) 36 

Actual delivery date 
(month): 

28/11/2025 

Deliverable number: D.2.2.1 

Dissemination Level: PU: Public (available on the project website) 

Type Report 

 
Disclaimer 
This activity was co-funded by the Interreg Alpine Space Programme 21-27. The views and opinions expressed in this 
document are solely those of the author(s) and do not necessarily reflect those of the Alpine Space Programme bodies 
or the project partners’ regions. Neither the Alpine Space Programme and its bodies nor any person acting on their 
behalf may be held responsible for the use of the information contained herein. 



3 

D.2.2.1: FOREST ECOSYSTEM SERVICES ASSESSMENT PILOT ACTION REPORT 
 

Summary 
1. Introduction ................................................................................................................................................6 

2. Project overview .........................................................................................................................................6 

3. Concise overview of the project's Living Labs (LLs) .....................................................................................8 

3.1 Living Labs: A European Approach to Innovation in Environment and Forestry ................................8 

3.1.1 Definition and European Perspective ..............................................................................................8 

3.1.2 Evolution and Applications..............................................................................................................8 

3.1.3 Living Labs in Environment and Forestry ........................................................................................8 

3.1.4 Perspectives for the Alpine Space ...................................................................................................9 

3.1.5 Examples of Environmental & Forestry Living Labs with alpine focus ............................................9 

3.1.6 Some references ........................................................................................................................... 10 

3.2 Overview of the Living Labs within the Forest Ecovalue Project ...................................................... 11 

3.2.1 Key features of Haute-Savoie, Grand Annecy and Thonon Agglomération , Inter-municipal 
cooperation bodies, France ...................................................................................................................... 11 

3.2.2 Key features of Alta Valle Tanaro LL, Piedmont, Italy ................................................................... 12 

3.2.3 Key features Tegernsee Valley, Upper Bavaria, Germany............................................................. 12 

3.2.4 Key features of Styria LL, Austria .................................................................................................. 14 

3.2.5 Key features of Karavanke Mountains, municipality Tržič LL, Slovenia......................................... 15 

4. Methodology: Scaling from Large-Scale Data (LSD) and maps to Local-Level Analysis (LLA).................... 16 

4.1 Methodological principle employed in the project for mapping and assessing Forest Ecosystem 
Services with LSD .......................................................................................................................................... 16 

4.1.1 Data Documentation ..................................................................................................................... 16 

4.1.2 Dataset Overview .......................................................................................................................... 16 

4.1.3 Methodological Information ......................................................................................................... 16 

4.1.4 Data Overview ............................................................................................................................... 17 

4.1.5 Indicators associated with each studied FES ................................................................................. 19 

5. Overview of the FES mapped outputs and indicator results for each Living Lab ...................................... 23 

5.1 LL1a: Grand Annecy France............................................................................................................... 23 

5.2 LL1b: Thonon Agglomération ............................................................................................................ 34 

5.3 LL2: Alta Valle Tanaro LL, Piedmont .................................................................................................. 44 

5.4 LL3: Tegernsee Valley, Upper Bavaria ............................................................................................... 55 

5.4.1 Results obtained for the test area ................................................................................................ 55 

5.4.2 Results obtained for the Living Lab ............................................................................................... 65 

5.5 LL4: Styria .......................................................................................................................................... 76 

5.5.1 Graz pilot area ............................................................................................................................... 76 

5.5.2 Thannhausen pilot area ................................................................................................................ 87 

5.6 LL5: Karavanke Mountains, municipality Tržič .................................................................................. 98 

5.7 Validation of large-scale biophysical assessments of FES using locally available data.................... 113 

Appendix 1: How to assess torrential hazard protection forest ecosystem service? ..................................... 116 



4 

D.2.2.1: FOREST ECOSYSTEM SERVICES ASSESSMENT PILOT ACTION REPORT 
 

The methodology proposed and implemented in the Forest EcoValue project ......................................... 116 

Massmov - Gravitational mass movement propagation model .................................................................. 117 

1. GENERAL OVERVIEW ........................................................................................................................... 117 

2. MODEL OBJECTIVES................................................................................................................................. 117 

3. INPUT DATA ......................................................................................................................................... 117 

4. PROPAGATION ALGORITHM ............................................................................................................... 117 

5. RESULTS AND EXPORTS ....................................................................................................................... 118 

STEP-BY-STEP: Watershed Delineation in QGIS .......................................................................................... 119 

1. Concepts ......................................................................................................................................... 119 

2. Step 1: Load the Digital Elevation Model (DEM) ............................................................................. 119 

3. Step 2: Fill Sinks (Remove Depressions) .......................................................................................... 119 

4. Step 3: Compute Flow Accumulation and Direction ....................................................................... 119 

5. Step 4: Identify and Create the Outlet Point .................................................................................. 119 

6. Step 5: Delineate the Watershed .................................................................................................... 120 

7. Step 6: Convert Watershed Raster to Polygon ............................................................................... 120 

8. Step 7: Calculate Watershed Area .................................................................................................. 120 

9. Optional Steps ................................................................................................................................. 120 

10. Common Errors to Avoid ............................................................................................................ 120 

Alternative (Simpler) STEP-BY-STEP: Watershed Delineation in QGIS + SAGA GIS ..................................... 122 

1. Step 1: Load the DEM...................................................................................................................... 122 

2. Step 2: Fill Sinks (Depression Filling) ............................................................................................... 122 

3. Step 3: Compute Flow Direction ..................................................................................................... 122 

4. Step 4: Create the Outlet Point ....................................................................................................... 122 

5. Step 5: Delineate the Watershed .................................................................................................... 122 

6. Step 6: Convert Watershed Raster to Polygon ............................................................................... 123 

7. Step 7: Calculate Basin Area ............................................................................................................ 123 

Tips & Common Errors ............................................................................................................................ 123 

Advantages of SAGA Method.................................................................................................................. 123 

Disadvantage of SAGA method ............................................................................................................... 123 

Appendix 2: Additional indicators beyond those used and usable at the local scale (specific field inventories, 
use of available field inventory data) .............................................................................................................. 125 

Timber indicators ........................................................................................................................................ 125 

Carbon Storage ........................................................................................................................................... 126 

Wood Energy .............................................................................................................................................. 129 

Biodiversity conservation ............................................................................................................................ 129 

Protection against natural hazards ............................................................................................................. 133 



5 

D.2.2.1: FOREST ECOSYSTEM SERVICES ASSESSMENT PILOT ACTION REPORT 
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1. Introduction 
 

The Forest Eco Value project aims to enhance the understanding and quantification of forest ecosystem 
services (FES) through an integrated approach combining spatial analysis, biophysical assessment, 
economical assessment and stakeholder engagement. Forest ecosystems provide a wide array of services—
ranging from carbon sequestration and biodiversity conservation to recreation and water regulation—that 
are essential for both environmental sustainability and human well-being. Despite their critical importance, 
these services are often undervalued or insufficiently integrated into policy and management frameworks. 

Deliverable D2.2.1 constitutes a core output of the project’s Work Package 2, focusing on the mapping and 
biophysical assessment of selected FES. This deliverable consolidates the methodological approaches, data 
processing workflows, and analytical results derived from the Living Labs established across different 
biogeographical regions. Each Living Lab served as an experimental platform for co-developing and testing 
assessment methodologies in collaboration with local stakeholders, thereby ensuring both scientific 
robustness and practical relevance. 

The outcomes presented in this report provide a comprehensive overview of the spatial distribution and 
biophysical performance of key forest ecosystem services. Furthermore, they establish the foundation for 
subsequent valuation and policy integration activities, supporting evidence-based decision-making and 
sustainable forest management within the framework of the Forest Eco Value project. 

2. Project overview 

Forests of the Alpine Space play a key role in climate change mitigation and resilience, providing multiple 
ecosystem services (ES) and environmental and social benefits such as CO₂ absorption, air pollution 
reduction, biodiversity enhancement, and protection against natural hazards. However, they are 
threatened by abandonment, climate change, and territorial degradation, which progressively reduce 
natural resources and the provision of ES. Maintenance costs of Alpine forests are high, and public funds 
and traditional wood value chains are insufficient to cover them. Economic valuation and payment schemes 
for ES are widely discussed but rarely successfully applied. 

The Forest EcoValue project addresses this challenge by developing innovative, sustainable business models 
for forest management and maintenance, supporting new bio-based value chains and ES markets, and 
involving different sectors, public and private actors, and citizens. Restoring and maintaining healthy forests 
has been recognized as a source of value for the Alpine region, while also creating business opportunities 
and green jobs for Alpine communities. 

The project focuses on a subset of Forest Ecosystem Services (FES) from the following categories: 

• Provisioning (e.g., biomass, raw materials, chemicals) with a specific focus on non-timber forest 
products, and on the production of woody biomass for energy, integrated into circular energy 
markets. 

• Regulation (e.g., biodiversity, natural risk reduction, CO₂ absorption) concretely working on carbon 
and biodiversity credits, natural risk management through protective forests, and innovative 
environmental finance instruments such as green bonds and reverse auctions. 
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• Cultural (e.g., recreation, habitat experience, health) particularly enhancing recreational and 
tourism services and spiritual and cultural services. 

These services have been explored and tested in five pilot Living Labs, located in different Alpine territories 
and representing diverse ecological and socio-economic contexts: 

• France - Haute-Savoie: Grand Annecy and Thonon Living Lab focuses respectively on two aspects 
1) recreational ecosystem services, enhancing the value of forests through the sale of experiences 
such as ecotourism, outdoor activities, and educational programs 2) enhancing the value of water 
regulation services through a public-private partnership. 

• Italy – Alta Valle Tanaro, Piedmont: The Living Lab in Valle Tanaro explores innovative approaches 
to valorizing chestnut groves, promoting non-timber forest products, developing carbon and 
biodiversity credits, and fostering experiential activities linked to forest and rural heritage. 

• Germany – Tegernsee Valley, Upper Bavaria: The German Living Lab explores spiritual and cultural 
services, such as forest cemeteries with biodegradable urns, while also fostering habitat and 
biodiversity conservation through collaborative public–private partnerships. 

• Austria – Province of Styria: The Styrian Living Lab concentrates on biodiversity and habitat 
conservation through innovative financing mechanisms such as reverse auctions, while also testing 
carbon sequestration and stability tools like green bonds. 

• Slovenia – Karavanke Mountains, Northern Slovenia: The Slovenian Living Lab addresses natural 
risk management through protective forests and develops models for producing woody biomass for 
energy, integrating forest resources with local energy markets. 

Accordingly, the project is aiming to: 

• Map and analyze the Alpine Space Forests (ASF) delivery capacity of FES; 

• Identify and estimate the economic potential, define business models and FES market 
frameworks; 

• Test the models/tools developed by the consortium in pilot living labs (LLs) involving local players; 

• Compare results at transnational level, identifying obstacles and facilitating factors; 

• Analyze the need for innovative policies to foster forest maintenance, ES markets, and new value 
chains; 

• Elaborate refined transferable tools/models and policy proposals to enable new markets and 
value chains and ensure the expected ES. 

Throughout the project, a continuous participatory process is carried out within the five pilot Living Labs. 
Stakeholders’ active involvement in these labs is essential for co-designing and testing models and tools, 
ensuring that the innovative approaches are rooted in local realities. In parallel, public events and capacity-
building workshops have strengthened engagement, supported knowledge transfer, and provided regular 
updates on project activities. This participatory and long-term approach, tested across the five territories, is 
paving the way for refined, transferable tools and policy proposals that can unlock new markets and value 
chains while safeguarding the provision of ecosystem services in the Alpine Space. 

Project duration: 42 months 
 

Disclaimer regarding the conditions and limitations governing the use of the data and analytical tools 
presented in this document. 
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The data, analyses, and tools included in this document are provided for informational purposes only. While 
every effort has been made to ensure their accuracy and reliability, they are provided "as is" without any 
warranty, express or implied, including but not limited to warranties of merchantability or fitness for a 
particular purpose. 

Users are solely responsible for how they interpret and use the information contained herein. The authors and 
publishers of this document accept no liability for any loss or damage arising directly or indirectly from the 
use of the data or analytical tools provided. 

Any reproduction, distribution, or use of the contents of this document must comply with the applicable legal 
and contractual obligations. Use of the data or tools for commercial, regulatory, or decision-making purposes 
should be undertaken with caution and, where necessary, supplemented by independent verification or 
expert advice 

3. Concise overview of the project's Living Labs (LLs) 
3.1 Living Labs: A European Approach to Innovation in Environment and Forestry 

3.1.1 Definition and European Perspective 
According to the European Network of Living Labs (ENoLL), Living Labs are user-centered open innovation 
ecosystems that integrate research and innovation in real-life communities and settings. Unlike traditional 
laboratories, they operate within everyday environments and actively involve end-users from the earliest 
stages of design, experimentation, and validation of new products, services, and policies. 

Key features of a LL are: 

• Co-creation / Open innovation: collaboration between public actors, private companies, academia, 
and citizens (the so called: Quadruple Helix model). 

• Real-life environments: experimentation takes place in authentic settings, not confined to 
laboratories. 

• Multi-method approaches: combining field observation, prototyping, surveys, digital tools, and 
participatory methods. 

• Territoriality: each Living Lab is rooted in a specific socio-economic and cultural context, often 
addressing local challenges. 

 

3.1.2 Evolution and Applications 
The concept of Living Labs emerged in the late 1990s, notably at MIT, to study technology use in everyday 
contexts. In Europe, the approach was institutionalized with the creation of ENoLL (2006), reflecting the rise 
of open innovation and citizen participation. 

 
Today, Living Labs are deployed across multiple domains, such as: 

• Health and ageing: supporting older adults, testing healthcare innovations. 

• Environment and agriculture: co-developing sustainable practices for water, soil, and biodiversity. 

• Forestry and climate: designing adaptive strategies for forests under climate stress. 
• Smart cities and ICT: testing mobility solutions, IoT, and public service innovations. 

 

3.1.3 Living Labs in Environment and Forestry 
Environmental and forest-related Living Labs address urgent challenges such as climate change, biodiversity 
loss, and conflicting uses of natural resources. They act as territorial platforms where science, policy, 
business, and local communities collaborate. 
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Governance and participation 

• Based on Public-Private-People-Partnerships (4Ps). 

• Involvement of diverse actors: researchers, forest managers, policymakers, industries, NGOs, and 
citizens. 

• Emphasis on participatory governance to co-design forest strategies and reduce conflicts. 
Benefits observed 

• Climate resilience: adaptive silvicultural practices, mixed-species forests, ecological corridors. 

• Biodiversity and ecosystem services: restoration of peatlands, forest edges, and riparian zones 
enhances carbon storage and ecological connectivity. 

• Conflict mitigation: participatory methods help balance tourism, conservation, timber, and energy 
needs. 

• Innovation acceleration: testing bio-based products, new monitoring tools, and circular economy 
models. 

Challenges 

• Temporal scale mismatch: long-term forest dynamics vs. short-term project funding. 

• Sustainability: many labs end after grants, raising continuity concerns. 

• Scalability: solutions often remain context-specific. 
• Governance complexity: balancing diverging priorities across stakeholders. 

• Ethical issues: ensuring fair participation, inclusiveness, and respect of local knowledge. 

 

3.1.4 Perspectives for the Alpine Space 
Living Labs are aligned with the European Green Deal, Horizon Europe, and Mission on Climate-Neutral and 
Smart Cities. They embody a shift towards open science, territorial innovation, and citizen engagement. 
The future directions are: 

• Establishing long-term monitoring platforms for ecological and social impacts. 

• Creating sustainable financing models (e.g., ecosystem services, carbon credits, bioeconomy). 

• Expanding comparative research across regions and forest types. 

• Strengthening policy integration to connect Living Lab outcomes to EU biodiversity and climate 
strategies. 

• Embedding citizen science and indigenous knowledge in co-design and monitoring. 

 

3.1.5 Examples of Environmental & Forestry Living Labs with alpine focus 
Living Lab / 
Project 

Region / 
Country 

Main Objectives Key 
Stakeholders 

Specific Focus 

Mountain 
Forest Living 
Lab 

Hautes-Alpes, 
France (Alps) 

Explore adaptation 
strategies for 
mountain forests 
facing droughts, 
pests, and storms. 

INRAE, ONF, 
municipalities, 
citizens 

Climate adaptation, 
biodiversity, 
multifunctional use 

AlpES – Alpine 
Ecosystem 
Services LL 

Alpine 
macroregion 
(FR, IT, AT, SI) 

Co-design tools & 
policies for 
ecosystem services. 

Municipalities, 
universities, 
NGOs, citizens 

Forest services: carbon, 
recreation, avalanche 
protection 

LIFE AdaptFor Italian Alps Develop adaptive 
silvicultural 

Forest 
agencies, 

Fire resilience, mixed-
species forestry 
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  practices under 
climate stress. 

landowners, 
researchers 

 

Waldlabor 
Zürich 

Switzerland Educate, 
experiment, and 
involve citizens in 
forest management. 

Municipality, 
schools, NGOs, 
universities 

Urban-forest interface, 
biodiversity, recreation 

Austrian Forest 
Dialogue 

Austria (Alps & 
pre-Alps) 

Stakeholder 
platform for forest 
strategy. 

Ministry of 
Agriculture & 
Forestry, 
NGOs, industry 

Sustainable governance, 
bioeconomy, Alpine 
resilience 

Forest’Inn Lab France 
(national, 
Alpine links) 

Collaborative 
innovation hub for 
forest transitions. 

AgroParisTech, 
SMEs, forest 
owners 

Bioeconomy, climate-
smart forestry 

SUPERB – 
Forest 
Restoration 

Alpine pilot 
sites 
(Slovenia, 
Austria) 

Large-scale 
restoration via 
diversification. 

EU research 
consortia, 
NGOs, 

landowners 

Post-disturbance 
restoration, mixed-forest 
promotion 

 
3.1.6 Some references 
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European Network of Living Labs (ENoLL). (2023). About us. Retrieved from https://enoll.org 
 

Leminen, S., Westerlund, M., & Nyström, A. G. (2012). Living Labs as open-innovation networks. Technology 
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Mauser, W., Klepper, G., Rice, M., Schmalzbauer, B. S., Hackmann, H., Leemans, R., & Moore, H. (2013). 
Transdisciplinary global change research: The co-creation of knowledge for sustainability. Current Opinion 
in Environmental Sustainability, 5(3–4), 420–431. https://doi.org/10.1016/j.cosust.2013.07.001 
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3.2 Overview of the Living Labs within the Forest Ecovalue Project 

 
3.2.1 Key features of Haute-Savoie, Grand Annecy and Thonon Agglomération , Inter-municipal 

cooperation bodies, France 

• Project partner in charge of the FEV activities coordination within Grand Annecy sub LL: Regional 
Centre for Forest Property (CNPF) with the support of PP9 French National Forest Service (ONF) 
PP10 

• Contact person(s): 
o Lauriane HENNET 
o Nicolas ANFRAY 
o Sylvain OUGIER 

• Contact email(s): 
o Lauriane.hennet@cnpf.fr 
o Nicolas.anfray@cnpf.fr 
o Sylvain.ougier@cnpf.fr 

• Main characteristics of the area: Grand Annecy 

o 23000 ha of forest cover (43% of overall surface, including the Annecy Lake), distribution of 
forest ownership: 42% of public and 58% of private forests, 11000 private owners. 

o Coordinates: 944411,22 6536940,45 
• Forest Ecosystem Services investigated: 

o Recreation 
o Biodiversity 
o Risk mitigation 
o Drinking water resource 

• Goal(s) of FLL: 
Grand Annecy is a highly touristic area where forests play an important role in regional 
attractiveness. However, climate change threatens these forests, and many tree species may 
experience high mortality rates. To ensure that forests continue to provide ecosystem services, 
especially recreational value and landscape permanence, management actions must be 
undertaken. The vision of the Living Lab is to engage recreational users in forest management, 
fostering their sense of stewardship and ownership over the challenges facing natural ecosystems. 
It aims to allocate a share of the tourism tax to fund actions that support foresters and forests in 
coping with the impacts of tourism and outdoor activities in the region. 

 

• Project partner in charge of the FEV activities coordination within Thonon Agglomération sub-LL: 
CNPF PP9 

• Contact person(s): 
o Lauriane HENNET 
o Nicolas ANFRAY 
o Sylvain OUGIER 

• Contact email(s): 
o Lauriane.hennet@cnpf.fr 
o Nicolas.anfray@cnpf.fr 
o Sylvain.ougier@cnpf.fr 

• Main characteristics of this area: 
o 10000 ha of forest cover (40% of overall surface, including the Leman Lake), distribution of 

forest ownership: 13% of public and 87% of private forests, with on average 1,2ha per 
owner. 

o Coordinates: 960748,184 6584701,272 

mailto:Lauriane.hennet@cnpf.fr
mailto:Nicolas.anfray@cnpf.fr
mailto:Sylvain.ougier@cnpf.fr
mailto:Lauriane.hennet@cnpf.fr
mailto:Nicolas.anfray@cnpf.fr
mailto:Sylvain.ougier@cnpf.fr
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• Forest Ecosystem Services investigated: 

• Biodiversity 

• Drinking water resource 

• Recreation 

• Goal(s) of FLL: 
Thonon Agglomeration is a dynamic conurbation benefiting from the Geneva economic basin. Forests are 
an integral part of the landscape and provide recreation, water purification and biodiversity reservoirs. 
However, climate change threatens these forests, and many tree species may experience high mortality 
rates. To ensure that forests continue to provide ecosystem services, especially biodiversity for species 
at risks and protection of water catchment, management actions must be undertaken. The vision of the 
Living Lab is to further engage private forest owner in forest management through a conciliating angle 
with biodiversity and recreational uses. In one hand this aims at generating more opportunities for 
funding and on the other end intent to attract a larger ensemble of forest owners. 

 

3.2.2 Key features of Alta Valle Tanaro LL, Piedmont, Italy 

• Project partner in charge of the FEV activities coordination within this LL: PP2 + WALDEN 

• Contact person(s): 

o Lucio Vaira 
• Contact email(s): 

o lucio.vaira@walden.srl 
• Main characteristics of this area: 

o 61% of forest cover 
o Distribution of forest ownership: 

▪ public property (State, Region, Provinces, Municipalities Property): 16% 
▪ private ownership taken over: 3% 
▪ other Entities: Consortia, mixed ownership (ASL, Uni., ENEL, AEM, Railways, etc. ): 

3% 
▪ other private properties, including undetected private properties, which means 

that their size is less than that required by the Technical Standards: 78% 
o Average forest area per type of ownership: in the case of Monte Armetta Forest 

Consortium, private partners own around 100-120 ha, while the municipality of Ormea 
owns around 1104. Outside the Consortium, ownership can be smaller. 

• Forest Ecosystem Services directly investigated: 
o Fuelwood 
o NWFP provision 
o Carbon sequestration 
o Ecotourism 

• Goal(s) of the LL: 
The Valle Tanaro Living Lab exists to design, test, and scale integrated forest management models 
that maintain and enhance key forest ecosystem services while creating tangible economic and social 
benefits for local communities. 

 

3.2.3 Key features Tegernsee Valley, Upper Bavaria, Germany. 

• Project partner in charge of the FEV activities coordination within this LL: ifuplan Institut für 
Umweltplanung und Raumentwicklung GmbH & Co. KG, PP6 

• Contact person: 

o Andrea Emmer 
• Contact email: 

mailto:lucio.vaira@walden.srl
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o andrea.emmer@ifuplan.de 
• Country, Region: 

Forest of Mr. L.B.: 
Germany, upper Bavaria, districts Miesbach and Bad Tölz-Wolfratshausen 
Church forest: 
Germany, upper Bavaria, 4 subparts in several districts. District Garmisch-
Partenkirchen “Gstaig“, district Bad Tölz-Wolfratshausen “Buchberg” and 
“Endlhausen”, district München “Sauerlach”. 

 

• Coordinates:  
Forest of Mr. L.B.: 
47.734565, 11.633211 
Church forest: 
“Gstaig”: 47.671282, 11.275191 
“Buchberg”: 47.878704, 11.450440 
“Endlhausen”: 47.942632, 11.573148 
“Sauerlach”: 47.958232, 11.673576 

 

• Main characteristics of this area: 

As the LL area was defined by us as the forest estates of the land owners, the forest cover is close to 100 
%. Mr. L. B. owns a total of 279 hectares, including 144 hectares of forest. The church forest covers 387 
hectares in total, with 317 hectares designated as forested land. 
The forest share in the greater region can be average with about 51% which includes the districts 
Miesbach (53%), Bad Tölz-Wolfratshausen (54%), Garmisch-Partenkirchen (51%), München (44%). The 
forest is mainly located in the highlands, whereas the lowlands are characterized by agricultural use. 
Data on forest ownership is only available for the districts of Miesbach and Bad Tölz-Wolfratshausen, as 
well as for the region of Upper Bavaria. The figures for these areas are quite similar. In the two 
districts, there are approximately 60,000 forest owners. 41% of the forest area there, is owned by the 
federal state, 55% is privately owned, and 4% is owned by municipalities. In Upper Bavaria, 41% of the 
forest area is owned by the federal state, 50% is privately owned, 7% belongs to municipalities, and 2% is 
owned by the German state. 

• Forest Ecosystem Services investigated: 
In the in both LLs we investigated the FES, Wood biomass production, carbon storage, recreation, 
drinking water provision and habitat provision. 

• Goal(s) of FLL: 
Forest of Mr. L.B.: 
Forest owner L. B. aims to enhance the recreational and educational function of his forest 
by launching a “Green Initiative,” which will serve as a platform for organizing educational 
programs, cultural events, and nature-based experiences. By collaborating with local artists, 
chefs, and community groups, he wants to create opportunities for people to connect with 
the forest, enjoy its atmosphere, and reflect on the relationship between nature and culture. 
The owners motivation for launching the Green Initiative is rooted in his commitment to 
making forest owner perspectives accessible and relevant to the broader public. He aims to 
foster dialogue, inspire creativity, and strengthen the recreational and educational value of 
his forest for everyone. 
Church forest: 
The church aims to enhance the FES of recreation by establishing a burial forest that offers a 
natural, low-maintenance alternative to traditional burial grounds. This aligns with the 
forest’s conservation goals and complementing existing structures like the nearby grief 
counselling centre. The motivation behind this goal is to respond to growing public demand 
for meaningful, sustainable burial options while preserving the forest’s ecological integrity, 

mailto:andrea.emmer@ifuplan.de
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thus creating a space that supports both community needs and long-term forest 
conservation. 

 

3.2.4 Key features of Styria LL, Austria 

• Project partner in charge of the FEV activities coordination within this LL: HCS PP11 and UNIGRAZ 
PP8 

• Contact person(s): 
o Alexander PINTER (PP11) 
o Kilian SILBERSCHNEIDER (PP11) 
o Victoria YAVORSKAYA (PP8) 

• Contact email(s): 
o pinter@holzcluster-steiermark.at 
o silberschneider@holzcluster-steiermark.at 
o vctoria.yavorskaya@uni-graz.at 

• Main characteristics of this area: 
o ca. 60% of forest cover 
o distribution of forest ownership: 87% of private, 9% of public and 4% municipality owned 

forest area; the average size of privately owned forest properties in the region is around 5–
10 hectares 

o number of owners classified by type of property 
o average forest area per type of ownership: the average size of privately owned forest 

properties in the region is around 5–10 hectares; 55% of total forest area are small-scale 
forest holdings (under 200 ha), 9% of forest area is of size 200-1000 ha and 23% of forest 
area are large forest holdings with areas larger than 1000 ha. 

• Forest Ecosystem Services investigated: habitat maintenance, carbon storage and sequestration, 
timber provision 

• Goal(s) of LL: 

o Ecological objectives 
Conserve and restore degraded forest ecosystems, particularly those impacted by 
monocultures, overexploitation, or biodiversity loss, aiming to re-establish ecologically 
functional and climate-resilient forest stands. 
Stabilize the carbon cycle through continuous cover forestry and diversified forest 
structures. 
Enhance biodiversity by preserving and improving habitats, tree species diversity, and 
structural complexity. 

o Economic objectives 
Create new funding opportunities for sustainable management and ecosystem service 
provision. 
Demonstrate viability, cost-efficiency and socio-ecological effectiveness of the of the 
proposed business model(s). 
Simplify procedures and improve advisory services to make sustainable forestry and 
ecosystem-based business models more accessible—especially for small-scale forest 
owners. 
Strengthen interest in active forest management, especially among owners with low 
management intensity or limited technical capacity. 
Support small-scale private forest owners, especially in implementing climate-adaptive and 
biodiversity-promoting measures. 
Ensure continuity of the pilot beyond the project duration, through stakeholder 
commitment and financial sustainability. 

mailto:pinter@holzcluster-steiermark.at
mailto:silberschneider@holzcluster-steiermark.at
mailto:vctoria.yavorskaya@uni-graz.at
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3.2.5 Key features of Karavanke Mountains, municipality Tržič LL, Slovenia 

• Project partner in charge of the FEV activities coordination within this LL: Slovenia Forest Service 
(SFS) PP5 

• Contact person(s): 
o Živa BONČINA 
o Tina SIMONČIČ 

• Contact email(s): 
o tina.simoncic@zgs.si 
o tina.simoncic@zgs.si 

• Main characteristics of this area: 
o 73% of forest cover 
o Tree species composition (% of growing stock): Norway spruce 60.0%, European beech 

21.4%, silver fir 8.1%, noble broadleaves 2.2%, hard broadleaves 1.6%, larch 3.7%, pine ssp. 
1.3%, oak ssp. 1.1% 

o Ownership: 85.5% private, 9.7% state, 4.7% municipality (more than 2000 forest owners) 
• Forest Ecosystem Services investigated: wood biomass, natural hazards (torrent management), 

recreation and tourism 

• Goal(s) of FLL: 
o WOOD BIOMASS 

Our objectives are to improve the assessment of potentials and demands for wood biomass 
within the municipality, to raise awareness among stakeholders—particularly the 
municipality—about the use of wood biomass, to activate sustainable forest management, 
and to generally promote the use of woody biomass. 
Biomass as a renewable energy source is supported by both the EU and national policies. 
The Municipality of Tržič is highly suitable for the use of wood biomass, as it is extensively 
forested and has a favorable ownership structure. Low-quality wood has traditionally been 
used for firewood, with part of it sold on the market. However, the municipality lacks major 
consumers of low-quality wood, such as wood-processing companies or larger municipal 
district heating systems based on wood biomass. 

o NATURAL HAZARD – TORRENT MANAGEMENT 
Our goal (beyond the scope of the current project) is to establish a system for torrent 
management. Within the project, we aim to initiate training for staff, strengthen 
collaboration with the water management sector, prepare forms for torrent inventory, 
identify problematic torrents, conduct field examination of problematic torrents, and 
assess the staffing and cost requirements at the level of the Slovenian Forest Service, as 
well as the need for additional silvicultural work in torrent-prone areas. 
Slovenia does not have a functioning system for torrent management, although in the past 
this field was managed by the state-owned company PUH. Torrent management is an 
intersectoral issue, where responsibilities between the water management sector, the 
forestry sector, forest owners, municipalities, and the state remain unclear. Increasingly 
frequent natural disasters—especially the catastrophic floods of August 2023—provide 
additional motivation to focus on preventive measures against torrent-related damage. 
Preventive actions are far less costly than disaster recovery and help reduce future risks. 
The management of protective forests, which also include torrent-prone areas, already 
involves many measures that mitigate the harmful impacts of torrents both within forests 
and downstream. 

o RECREATION AND TOURISM 

We aim to foster recreation and tourism that are harmonized with forestry and other land 
uses. During the project, we seek to gather information on different stakeholders in the 

mailto:tina.simoncic@zgs.si
mailto:tina.simoncic@zgs.si
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fields of recreation and tourism, connect these stakeholders, assess recreation in forests, 
and develop strategies to reduce potential conflicts among different land users. 
Forest visitation is steadily increasing, bringing with it new forms of land use that are not 
always harmonized. At the same time, forest areas represent significant potential for 
diverse entrepreneurial initiatives. 

4. Methodology: Scaling from Large-Scale Data (LSD) and maps to 
Local-Level Analysis (LLA) 

4.1 Methodological principle employed in the project for mapping and assessing 
Forest Ecosystem Services with LSD 

By INRAE 

4.1.1 Data Documentation 
Dataset: ForestEcoValue_data_europe 

Version: 0.1 
Date: 15 June 2025 
Prepared by: Baptiste Desbuquois, Frederic Berger (INRAE) 
Contact: baptiste.desbuquois@inrae.fr 

4.1.2 Dataset Overview 

• Dataset Title: ForestEcoValue_data_europe 

• Dataset access: The dataset will be made available as of 30 April 2026 through the WebAtlas of the 
Interreg Alpine Space Mosaic project (https://alpineresilience.org/data). 

• Date of Creation: 11 December 2024 

• Latest Update: 10 October 2025 

• Contact Person: Baptiste Desbuquois, INRAE 

• Contact Email: baptiste.desbuquois@inrae.fr 

4.1.3 Methodological Information 

4.1.3.1 Environmental / Experimental Context 

The dataset provides a comprehensive mapping of forest-based ecosystem services across territories 
involved in the Living Labs of the ForestEcoValue project. 

4.1.3.2 Data Sources and Methods 

The dataset consolidates multiple data sources and spatial analyses (For more detailed information, readers 
are encouraged to refer to the project’s deliverable D.1.2.1 : Report on biophysical foundations and 
methodologies for the assessment of selected FES) including: 

• Interreg Alpines Space project AlpTrees data set provided by CEREMA (with a specific attention 
paid to timber stock datasets for estimating timber and carbon values). 

• OpenStreetMap-derived layers for proximity and visibility analyses. 

• Natura 2000 and national protected area databases. 
• INRAE (Interreg Alpines Space project RockTheAlps) spatial analysis for identification of protective 

forests against rockafall risks. 

• For the torrential hazard protection service, which applies only to the Slovenian FLL, the data, along 
with the analysis methodology employed, are presented in Appendix 1 of this document. 

• QGIS and DTM-based visibility analyses using OSM viewpoint points. 
• Dataset (from 2017 to 2023) on forest biomass, stock volume, growing stock available via the 

Forest Carbon Monitoring portal: https://portal.forestcarbonplatform.org/ 

mailto:baptiste.desbuquois@inrae.fr
https://alpineresilience.org/data
mailto:baptiste.desbuquois@inrae.fr
https://portal.forestcarbonplatform.org/
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4.1.3.3 Data Quality Assurance 

The dataset reflects the best approximations and models available at the time of its production. It is not 
meant to replace any field measure and can never be better than local expertise 

4.1.3.4 Contextual Background 

The dataset was developed as part of the FORESTECOVALUE project under the Interreg Alpine Space 
programme. 
This dataset provides an essential foundation for assessing ecosystem services delivered by forests in the 
Alpine Space and at a regional scale. It brings together a wide range of reliable and harmonized spatial 
sources, enabling the exploration of ecological, economic, and social dimensions. By integrating 
information on carbon storage, landscape visibility, proximity to protected areas, and other environmental 
indicators, it offers a robust decision-support tool for stakeholders involved in sustainable forest 
management. 
Beyond its application within the FORESTECOVALUE project, this dataset can also serve as a reference for 
other regional or European initiatives aiming to enhance the multiple functions of forest ecosystems. It 
represents a solid starting point for improving our understanding of the interactions between ecosystem 
services and land-use planning. 

 

4.1.4 Data Overview 

4.1.4.1 File Naming Convention 

Files are named using the structure: data_countryname (e.g., data_france.shp). the data that has been 
produced are used the data alleviable for the area of interest. So, some maps can be missing if the data 
were not alleviable. 

4.1.4.2 Layer-Specific Metadata 

Layer: forest data 

To build this map we used, CEREMA data about timber stock stored into the INTERREG MOSAIC web atlas. 
A multiplication of this volume by 0.475 has been done to calculate the carbon storage masse. This gives us 
the following attribute table for this layer 

Variable Description Unit 

FID Polygon identifier - 

mean_value Mean timber stock (CEREMA) m³/ha 

carbon_stored Carbon stored (47.5.% of the 
timber stock) 

t/ha 

Layer: large_visibility_50m 

For this layer an extraction of the circulation path of open street map using the request access in quickOSM 
on qgis. We the applied a 50m buffer on all access and extract the area that where in the forest. With those 
remaining area we got the following attribute table: 

Variable Description Unit 

fid Polygon identifier - 

Layer: short_visibility_20m 

For this layer an extraction of the circulation path of open street map using the request access in quickOSM 
on qgis. We the applied a 20m buffer on all access and extract the area that where in the forest. With those 
remaining area we got the following attribute table 

Variable Description Unit 
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fid Polygon identifier - 

Layer: protected area 

This layer is composed by the shapes of the protected area of the living lab. Most are alleviable on N2000 
web site. The total layer is resampled to be only on forest and so keep the high protection status forest 
with the following attribute table 

Variable Description Unit 

FID Polygon identifier - 

SITECODE Natura 2000 site code - 

SITENAME Site name - 

MS Country code - 

SITETYPE Type of habitat protection - 

INSPIRE_ID INSPIRE-compliant site 
identifier 

- 

Layer: riparian forest 

This layer is constructed form the map of the river obtain with the request: “waterway” in QUICKOSM 
plugin form QGIS. From Those rivers a 20m buffer is added. To this polygon, we extract only the area whit 
forest. We then get the riparian forest layer with the following attribute table: 

Variable Description Unit 

FID Polygon identifier - 

name River name - 

Layer: protective forest 

For this layer we use the row data form the ALPTREES INTERREG program. The maps provided are 
resampled on the LivinbgLabs area and identified with this attribute table: 

Variable Description Unit 

fid Polygon identifier - 

NUTS_ID European NUTS region 
identifier 

- 

source Source of the data - 

S_km2 Surface area of protective 
forest 

km² 

Layer: visibility 

This layer has been build using the viewpoints extract using the research “tourism, viewpoints” in the plug 
in QICK OSM form QGIS those viewpoints are used to calculate along with the DTM are used as an entry in 
the plug in Visibility analysis to calculate the number of viewpoints from which the polygon is visible. This 
gives us the following attribute table: 

Variable Description Unit 
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fid Polygon identifier - 

DN Number of viewpoints from 
which the polygon is visible 

- 

 
4.1.5 Indicators associated with each studied FES 

To enable systematic comparison among the various FES and to standardize the presentation of results, a 
set of dendrometric parameters was quantified for each living lab. These parameters were computed for 
each of the mapped FES zones and are hereafter referred to as “indicators.” 

For each FES/LL, the indicators are presented as follows: 

 

 
Total for the Living Lab 

Biodiversity/Habitat 
support 

Protection 
against 
natural 
hazards 

Production 
(biomass, 
carbon) 

 
Tourism/Recreation 

Total area (ha) 
    

mean carbon stored (t/ha) 
    

mean timber stock (m3/ha) 
    

mean annual growing stock 
(m3/ha.year): high-range 
estimate 

    

mean annual growing stock 
(m3/ha.year): mid-range 
estimate 

    

mean annual growing stock 
(m3/ha.year): low-range 
estimate 

    

Carbon sequestration 
(T/ha.year): high-range 
estimate 

    

Carbon sequestration (T/year): 
mid-range estimate 

    

Carbon sequestration 
(T/ha.year): low-range 
estimate 

    

FES in % of the total forest area     

 

 

Total for the Living Lab 
Deciduous 

stand 
Coniferous 

stand 
Mixed 
stand 

Total areal (ha)    

mean carbon stored (t/ha)    

mean timber volume (m3/ha)    
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mean annual growing stock (m3/ha.year): high-range estimate    

mean annual growing stock (m3/ha.year): mid-range estimate    

mean annual growing stock (m3/ha.year): low-range estimate    

Carbon sequestration (T/ha.year): high-range estimate    

Carbon sequestration (T/year): mid-range estimate    

Carbon sequestration (T/ha.year): low -range-estimate    

% of forest stands    

 

FES « XXX » 
Deciduous 

stand 
Coniferous 

stand 
Mixed 
stand 

Total areal (ha)    

mean carbon stored (t/ha)    

mean timber volume (m3/ha)    

mean annual growing stock (m3/ha.year): high-range estimate    

mean annual growing stock (m3/ha.year): mid-range estimate    

mean annual growing stock (m3/ha.year): low-range estimate    

Carbon sequestration (T/ha.year): high-range estimate    

Carbon sequestration (T/ha.year): mid-range estimate    

Carbon sequestration (T/ha.year): low-range estimate    

% of forest stands    

 
For the Growing Stock Volume (GSV) and mean annual increment, we used data published by the platform of 
the European Forest Carbon Monitoring project (https://www.forestcarbonplatform.org/). 

These data are generated using the BIOMASAR method, which is based on Sentinel-1 and ALOS-2 PALSAR- 
2 observations at a 20-metre resolution. BIOMASAR is an algorithm that estimates various forest 
variables—such as GSV and above-ground biomass (AGB)—using canopy density and height as input 
parameters. 

We extracted the relevant data for 2017 and 2023 within the geographical extent of the LLs. The variation 
in GSV between these two years was computed by subtracting the 2023 values from the 2017 values. 

A biomass decrease mask (also provided by the Forest Carbon Monitoring platform) was then applied to 
retain only areas that had not been affected by forestry operations or storm damage. Finally, we kept only 
the pixels showing a positive variation, in order to identify areas of forest growth. Using the documentation 
available on this site, we also calculated three estimation categories: 

• a high-range estimate, corresponding to the result obtained directly from the raw data available on 
the platform, 

• a mid-range estimate, corresponding to the application of a corrective factor of 86.80%, 

• a low-range estimate, corresponding to the application of a corrective factor of 63.43%. 

• Note: a very low-range estimate can also be calculated using a corrective factor of 45,99%. This 
estimation is not presented in the tables given for each FLL. 

These three categories have a direct impact on the assessment of carbon sequestration, since 
sequestration is calculated from the average annual increment. The same applies to assessing the volume of 
wood that can be mobilized for energy purposes. The percentage of annual growth allocated to fuel wood 
is a local figure which, if known, can then be used together with the growth data we provide 

https://www.forestcarbonplatform.org/
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Since these data are initially derived from the analysis of satellite imagery, the accuracy of the estimates 
depends directly on the quality of the input data, which may vary within a single image (variable viewing 
angle, presence of clouds or shadowed areas, etc.). Thus, for each territory, the choice of which estimation 
category to use must be made according to the locally, regionally, or nationally available data. In all cases, 
the choice should ensure that the resulting order of magnitude remains consistent. 

For the rockfall hazard protection service (as a reminder, the German Living Lab is not concerned by this 
FES) a complementary indicator was calculated based on the nature of the assets being protected. For road 
networks, this indicator corresponds to the percentage of total road length that is potentially protected by 
upstream forested areas. To compute this indicator, the total length of the road network and the portion of 
that length potentially protected by forested areas were calculated, and the ratio of protected length to 
total length was then expressed as a percentage. 

With regard to buildings, only the total number of buildings potentially protected was calculated. These are 
buildings located (1) within a maximum rockfall propagation zone—without accounting for the effect of 
forest vegetation in the simulation work—and (2) downstream of a forested slope. The results were then 
grouped into numerical classes. Only the French living lab is concerned by this indicator. 

For the torrential hazard protection service, which applies only to the Slovenian FLL, the indicators are 
expressed without counting the protected assets. They were established (1) for forest areas that can supply 
woody debris to watercourses (torrents/rivers)—thus requiring specific maintenance to avoid increasing 
the hazard—and (2) for forest sectors within the drainage basins of the watercourses. The total surface 
area of the protected zone was calculated. This approach was selected for this ecosystem service given that 
the statistical model used is currently undergoing operational testing. 

For the Drinking Water Resource service, due to the sensitive nature of this resource, the mapping data 
required for the biophysical assessment of this FES are, depending on the country and territory, subject to 
access restrictions and therefore not available. Given this situation, a simple and operational—though non-
cartographic—methodology is proposed. It is based on (1) the observation that water captured from forest 
springs is of higher quality and requires little or no purification, and (2) the type and minimum level of data 
that the stakeholders of the study area are able to provide. 

This methodology relies on the total drinking water consumption of the study area, the share coming from 
forest water intakes (also known as water collection point), and the potential to create new intakes in 
forested zones. For the study area, the data that are both necessary and sufficient are: the total forest area, 
the surface area of protection perimeters for forest water intakes, the total drinking water consumption 
from all production sources combined (forest spring intakes, karstic gravity-fed springs, boreholes, surface-
water pumping, etc.), and the percentage share of “forest water” in the total production. These data make 
it possible to assess, both in terms of production share and proportion of forest area, the importance of this 
FES at the scale of the study area. 

A prospective analysis can be carried out if the number or percentage of forest springs that are currently 
uncaptured is available. To estimate the forest area associated with these potential new forest water intake 
zones, and provided that the geographic coordinates of the springs are known, a 3-km-radius buffer can be 
created around each spring (this distance is non-planimetric and therefore requires a digital elevation 
model to compute the buffer along the slope). The results of this buffer can then be intersected with the 
watershed (also known as the drainage basin) feeding each spring, in order to estimate the potentially 
concerned forest area. 

If, for the study area, all data are available as GIS-ready geographic information layers, it becomes possible to 
compute for these forest areas the same indicators presented in the three tables above, thus harmonizing 
the presentation of results with those of the other ES assessed in the territory. 
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5. Overview of the FES mapped outputs and indicator results for 
each Living Lab 

This section of the report provides, for each Living Lab, an overview of the maps generated for a 

standardized set of 5 forest ecosystem services, with two supplementary services incorporated specifically 

for the Slovenian Living Lab (protective forest against snow avalanches and protective forest against 

torrential hazards). Depending on the countries, some spatial data on water-related services are not 

publicly available; however, indicators (Forest composition types: deciduous, mixed, and coniferous) have 

been calculated that can serve as proxies to assess the potential of water-related forest ecosystem service. 

5.1 LL1a: Grand Annecy France 
• FES1: map of forest areas with high biodiversity and habitat support potential (support service) 
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• FES 2: map of volume standing timber (production service) 
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• FES3: map of carbon storage in forest areas (regulation service) 
 



25 

D.2.2.1: FOREST ECOSYSTEM SERVICES ASSESSMENT PILOT ACTION REPORT 
 

• FES4: map of protective forest against rockfall risks (regulation service) 
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• FES 5: map of high visual interest (cultural service) 
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• FES 6: map of growing stock volume (regulation and support service) 
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• FES 7: map of growing stock volume increment (regulation and support service) 
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• Map of main forest stand types (supporting all FESs biophysical assessment) 
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• Synthesis table listing each FES with its associated indicator and value 
 
 

 

 Deciduous Coniferous Mixed 

Area total (ha) 9024,22 6611,83 8680,95 

mean Carbon stored (T/ha) 118,51 88,06 113,97 

Total Carbon stored (T) 1069503,20 582224,99 989327,71 

mean Volume (m3/ha) 325,3423 357,0051 376,6796 

Total Volume (m3) 2935961,79 2360458,10 3269936,02 

mean Growth (m3/ha.year): high-range estimate 4,07692 5,997423 5,502313 

mean Growth (m3/ha.year): mid-range estimate 3,13 4,61 4,23 

mean Growth (m3/ha.year): low-range estimate 2,59 3,80 3,49 

Carbon sequestration (T/year): high estimate 1,94 2,85 2,61 

Carbon sequestration (T/year): mid-range estimate 1,49 2,19 2,01 

Carbon sequestration (T/year): low-range estimate 1,23 1,81 1,66 

% of forest stands 37,11% 27,19% 35,70% 

 
 

 

 Biodiversity Production Protective Tourism 

Area total (ha) 1299,60 26208,82 8678,05 22945,33 

mean Carbon stored (T/ha) 135,33 116,53 105,09 122,06 

mean Volume (m3/ha) 408,24 378,24 346,84 397,35 

mean Growth (m3/ha.year): high-range estimate 5,29 6,53 7,86 6,38 

mean Growth (m3/ha.year): mid-range estimate 4,06 5,02 6,04 4,90 

mean Growth (m3/ha.year): low-range estimate 3,36 4,14 4,99 4,05 

Carbon sequestration (T/ha.year): high-range estimate 2,51 3,10 3,73 3,03 

Carbon sequestration (T/year): mid-range estimate 1,93 2,38 2,87 2,33 

Carbon sequestration (T/ha.year): low-range estimate 1,59 1,97 2,37 1,92 

FES in % of the total forest area 4,96% 100,00% 33,11% 87,55% 
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BIODIVERSITE Deciduous Coniferous Mixed 

Area total (ha) 746,74 120,08 32,33 

mean Carbon stored (T/ha) 146,63 106,66 133,95 

Total Carbon stored (T) 109494,06 12808,24 4331,12 

mean Volume (m3/ha) 402,70 444,75 444,62 

Total Volume (m3) 300716,14 53406,63 14376,39 

mean Growth (m3/ha.year): high-range estimate 5,26 5,81 5,04 

mean Growth (m3/ha.year): mid-range estimate 4,04 4,46 3,87 

mean Growth (m3/ha.year): low estimate 3,34 3,69 3,19 

Carbon sequestration (T/ha.year): high-range estimate 2,50 2,76 2,39 

Carbon sequestration (T/year): mid-range estimate 1,92 2,12 1,84 

Carbon sequestration (T/ha.year): low-range estimate 1,58 1,75 1,52 

% of forest stands 83,05% 13,36% 3,60% 

 
 

 

PRODUCTION Deciduous Coniferous Mixed 

Area total (ha) 8944,33 6320,37 8546,00 

mean Carbon stored (T/ha) 143,61 98,03 130,58 

Total Carbon stored (T) 1284527,35 619572,79 1115949,10 

mean Volume (m3/ha) 394,76 405,86 433,06 

Total Volume (m3) 3530842,40 2565208,18 3700942,03 

mean Growth (m3/ha.year): high-range estimate 6,65 7,27 7,12 

mean Growth (m3/ha.year): mid-range estimate 5,11 5,58 5,47 

mean Growth (m3/ha.year): low estimate 4,22 4,61 4,52 

Carbon sequestration (T/ha.year): high-range estimate 3,16 3,45 3,38 

Carbon sequestration (T/year): mid-range estimate 2,43 2,65 2,60 

Carbon sequestration (T/ha.year): low-range estimate 2,00 2,19 2,15 

% of forest stands 37,56% 26,54% 35,89% 
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PROTECTIVE Deciduous Coniferous Mixed 

Area total (ha) 2287,12 1776,17 3053,67 

mean Carbon (T/ha) 135,69 105,31 135,77 

Total Carbon (T) 310345,20 187055,79 414603,24 

mean Volume (m3/ha) 373,75 438,71 450,57 

Total Volume (m3) 854814,93 779220,31 1375878,67 

mean Growth (m3/ha.year): high-range estimate 9,39 5,70 7,68 

mean Growth (m3/ha.year): mid-range estimate 7,21 4,37 5,90 

mean Growth (m3/ha.year): low estimate 5,96 3,61 4,87 

Carbon sequestration (T/ha.year): high-range estimate 4,46 2,71 3,65 

Carbon sequestration (T/year): mid-range estimate 3,43 2,08 2,80 

Carbon sequestration (T/ha.year): low-range estimate 2,83 1,72 2,32 

% of forest stands 32,14% 24,96% 42,91% 

 

PROTECTIVE Deciduous Coniferous Mixed 

Area total (ha) 2287,12 1776,17 3053,67 

mean Carbon (T/ha) 135,69 105,31 135,77 

Total Carbon (T) 310345,20 187055,79 414603,24 

mean Volume (m3/ha) 373,75 438,71 450,57 

Total Volume (m3) 854814,93 779220,31 1375878,67 

mean Growth (m3/ha.year): high-range estimate 9,39 5,70 7,68 

mean Growth (m3/ha.year): mid-range estimate 7,21 4,37 5,90 

mean Growth (m3/ha.year): low estimate 5,96 3,61 4,87 

Carbon sequestration (T/ha.year): high-range estimate 4,46 2,71 3,65 

Carbon sequestration (T/year): mid-range estimate 3,43 2,08 2,80 

Carbon sequestration (T/ha.year): low-range estimate 2,83 1,72 2,32 

% of forest stands 32,14% 24,96% 42,91% 

 

Total road length within the living lab area (km) 2694,7 

Road length protected by protection forests (km) 82,2 

Percentage of roads protected by forest (%) 3,05% 

Total number of buildings protected by protection forest 1648 
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5.2 LL1b: Thonon Agglomération 
• FES1: map of forest areas with high biodiversity and habitat support potential (support service) 
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• FES 2: map of volume standing timber (timber production service) 
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• FES3: map of carbon storage in forest areas (regulation service) 
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• FES 4: map of high visual interest (cultural service) 
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• FES 6: map of growing stock volume (regulation and support service) 
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• FES 7: map of growing stock volume increment (regulation and support service) 
•  
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• Map of main forest stand types (supporting all FESs biophysical assessment) 
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• Synthesis table listing each FES with its associated indicator and value 
 
 

 

 Deciduous Coniferous Mixed 

Area total (ha) 5830,61 742,67 2977,71 

mean Carbon stored (T/ha) 110,94 109,25 119,84 

Total Carbon stored (T) 646828,38 81140,08 356833,64 

mean Volume (m3/ha) 303,8743 433,311 397,1185 

Total Volume (m3) 1771773,44 321806,95 1182502,93 

mean Growth (m3/ha.year): high-range estimate 3,294701 4,731399 4,34326 

mean Growth (m3/ha.year): mid-range estimate 2,53 3,63 3,34 

mean Growth (m3/ha.year): low-range estimate 2,09 3,00 2,75 

Carbon sequestration (T/year): high estimate 1,56 2,25 2,06 

Carbon sequestration (T/year): mid-range estimate 1,20 1,73 1,58 

Carbon sequestration (T/year): low-range estimate 0,99 1,43 1,31 

% of forest stands 61,05% 7,78% 31,18% 

 
 

 

 Biodiversity Production Protective Tourism 

Area total (ha) 1333,36 9696,21 0,00 9409,60 

mean Carbon stored (T/ha) 68,49 136,03 0,00 137,57 

mean Volume (m3/ha) 202,99 408,44 0,00 413,42 

mean Growth (m3/ha.year): high-range estimate 3,52 4,76 0,00 4,91 

mean Growth (m3/ha.year): mid-range estimate 2,70 3,66 0,00 3,77 

mean Growth (m3/ha.year): low-range estimate 2,23 3,02 0,00 3,12 

Carbon sequestration (T/ha.year): high-range estimate 1,67 2,26 0,00 2,33 

Carbon sequestration (T/year): mid-range estimate 1,28 1,74 0,00 1,79 

Carbon sequestration (T/ha.year) : low-range estimate 1,06 1,44 0,00 1,48 

FES in % of the total forest area 13,75% 100,00% 0,00% 97,04% 
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BIODIVERSITE Deciduous Coniferous Mixed 

Area total (ha) 491,34 35,77 223,88 

mean Carbon stored (T/ha) 123,72 94,54 121,27 

Total Carbon stored (T) 60790,93 3381,46 27150,88 

mean Volume (m3/ha) 338,90 394,84 402,11 

Total Volume (m3) 166517,64 14121,82 90025,50 

mean Growth (m3/ha.year): high-range estimate 3,90 4,26 5,20 

mean Growth (m3/ha.year): mid-range estimate 3,00 3,27 3,99 

mean Growth (m3/ha.year): low estimate 2,48 2,70 3,30 

Carbon sequestration (T/ha.year): high-range estimate 1,85 2,02 2,47 

Carbon sequestration (T/year): mid-range estimate 1,42 1,55 1,90 

Carbon sequestration (T/ha.year): low-range estimate 1,18 1,28 1,57 

% of forest stands 65,43% 4,76% 29,81% 

 

PRODUCTION Deciduous Coniferous Mixed 

Area total (ha) 5794,35 695,59 2969,63 

mean Carbon stored (T/ha) 144,27 116,34 131,86 

Total Carbon stored (T) 835960,86 80924,34 391578,93 

mean Volume (m3/ha) 394,35 485,15 437,94 

Total Volume (m3) 2285009,07 337464,95 1300506,34 

mean Growth (m3/ha.year): high-range estimate 4,73 5,24 4,89 

mean Growth (m3/ha.year): mid-range estimate 3,63 4,02 3,76 

mean Growth (m3/ha.year): low estimate 3,00 3,32 3,10 

Carbon sequestration (T/ha.year): high-range estimate 2,25 2,49 2,32 

Carbon sequestration (T/year): mid-range estimate 1,72 1,91 1,78 

Carbon sequestration (T/ha.year): low-range estimate 1,42 1,58 1,47 

% of forest stands 61,25% 7,35% 31,39% 
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TOURISM Deciduous Coniferous Mixed 

Area total (ha) 5678,42 719,90 2948,44 

mean Carbon (T/ha) 144,28 116,76 131,77 

Total Carbon (T) 819277,11 84055,86 388530,65 

mean Volume (m3/ha) 394,36 486,82 437,65 

Total Volume (m3) 2239330,89 350459,88 1290381,59 

mean Growth (m3/ha.year): high-range estimate 4,88 5,01 4,97 

mean Growth (m3/ha.year): mid-range estimate 3,75 3,85 3,82 

mean Growth (m3/ha.year): low estimate 3,09 3,18 3,16 

Carbon sequestration (T/ha.year): high-range estimate 2,32 2,38 2,36 

Carbon sequestration (T/year): mid-range estimate 1,78 1,83 1,81 

Carbon sequestration (T/ha.year): low-range estimate 1,47 1,51 1,50 

% of forest stands 60,75% 7,70% 31,55% 
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5.3 LL2: Alta Valle Tanaro LL, Piedmont. 
• FES1: map of forest areas with high biodiversity and habitat support potential (support service) 
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• FES 2: map of volume standing timber (timber production service) 
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• FES3: map of carbon storage in forest areas (regulation service) 
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• FES4: map of protective forest against rockfall risks (regulation service) 
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• FES 5: map of high visual interest (cultural service) 
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• FES 6: map of growing stock volume (regulation and support service) 
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• FES 7: map of growing stock volume increment (regulation and support service) 
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• Map of main forest stand types (supporting all FESs biophysical assessment) 
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• Synthesis table listing each FES with its associated indicator and value 
 

 

 Deciduous Coniferous Mixed 

Area total (ha) 37872,51 2709,53 2773,84 

mean Carbon stored (T/ha) 105,94 92,66 105,00 

Total Carbon stored (T) 4012213,71 251059,79 291242,14 

mean Volume (m3/ha) 429,4023 375,5679 425,5757 

Total Volume (m3) 16262542,90 1017610,61 1180480,18 

mean Growth (m3/ha.year): high-range estimate 7,501418 4,031248 6,548937 

mean Growth (m3/ha.year): mid-range estimate 5,76 3,10 5,03 

mean Growth (m3/ha.year): low-range estimate 4,76 2,56 4,15 

Carbon sequestration (T/year): high estimate 3,56 1,91 3,11 

Carbon sequestration (T/year): mid-range estimate 2,74 1,47 2,39 

Carbon sequestration (T/year): low-range estimate 2,26 1,21 1,97 

% of forest stands 87,35% 6,25% 6,40% 

 

 Biodiversity Production Protective Tourism 

Area total (ha) 43355,88 43355,88 6796,12 19879,04 

mean Carbon stored (T/ha) 101,78 101,78 48,54 102,84 

mean Volume (m3/ha) 412,56 412,56 196,73 416,83 

mean Growth (m3/ha.year): high-range estimate 7,27 7,27 5,72 7,49 

mean Growth (m3/ha.year): mid-range estimate 5,58 5,58 4,40 5,75 

mean Growth (m3/ha.year): low-range estimate 4,61 4,61 3,63 4,75 

Carbon sequestration (T/ha.year): high-range estimate 3,45 3,45 2,72 3,56 

Carbon sequestration (T/year): mid-range estimate 2,65 2,65 2,09 2,73 

Carbon sequestration (T/ha.year) : low-range estimate 2,19 2,19 1,72 2,26 

FES in % of the total forest area 100,00% 100,00% 15,68% 45,85% 
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BIODIVERSITE Deciduous Coniferous Mixed 

Area total (ha) 37872,51 2709,52 2773,84 

mean Carbon stored (T/ha) 102,97 87,38 99,64 

Total Carbon stored (T) 3899770,61 236761,03 276385,75 

mean Volume (m3/ha) 417,37 354,18 403,87 

Total Volume (m3) 15806783,56 959653,98 1120263,28 

mean Growth (m3/ha.year): high-range estimate 7,64 3,22 6,19 

mean Growth (m3/ha.year): mid-range estimate 5,87 2,48 4,75 

mean Growth (m3/ha.year): low estimate 4,84 2,05 3,92 

Carbon sequestration (T/ha.year): high-range estimate 3,63 1,53 2,94 

Carbon sequestration (T/year): mid-range estimate 2,79 1,18 2,26 

Carbon sequestration (T/ha.year): low-range estimate 2,30 0,97 1,86 

% of forest stands 87,35% 6,25% 6,40% 

 

PRODUCTION Deciduous Coniferous Mixed 

Area total (ha) 37855,16 2684,73 2766,00 

mean Carbon stored (T/ha) 102,99 87,75 99,63 

Total Carbon stored (T) 3898839,64 235585,64 275588,81 

mean Volume (m3/ha) 417,46 355,67 403,84 

Total Volume (m3) 15803010,41 954889,82 1117033,06 

mean Growth (m3/ha.year): high-range estimate 7,64 3,25 6,20 

mean Growth (m3/ha.year): mid-range estimate 5,87 2,50 4,76 

mean Growth (m3/ha.year): low estimate 4,85 2,06 3,94 

Carbon sequestration (T/ha.year): high-range estimate 3,63 1,55 2,95 

Carbon sequestration (T/year): mid-range estimate 2,79 1,19 2,26 

Carbon sequestration (T/ha.year): low-range estimate 2,30 0,98 1,87 

% of forest stands 87,41% 6,20% 6,39% 
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PROTECTIVE Deciduous Coniferous Mixed 

Area total (ha) 5252,27 602,07 941,79 

mean Carbon (T/ha) 106,78 92,92 102,74 

Total Carbon (T) 560855,49 55945,22 96763,08 

mean Volume (m3/ha) 432,82 376,64 416,45 

Total Volume (m3) 2273293,03 226760,53 392205,90 

mean Growth (m3/ha.year): high-range estimate 6,07 3,23 5,52 

mean Growth (m3/ha.year): mid-range estimate 4,66 2,48 4,24 

mean Growth (m3/ha.year): low estimate 3,85 2,05 3,50 

Carbon sequestration (T/ha.year): high-range estimate 2,88 1,53 2,62 

Carbon sequestration (T/year): mid-range estimate 2,21 1,18 2,01 

Carbon sequestration (T/ha.year): low-range estimate 1,83 0,97 1,66 

% of forest stands 77,28% 8,86% 13,86% 

 

TOURISM Deciduous Coniferous Mixed 

Area total (ha) 17496,92 927,09 1456,33 

mean Carbon (T/ha) 103,69 90,80 100,21 

Total Carbon (T) 1814228,15 84183,64 145933,76 

mean Volume (m3/ha) 420,28 368,05 406,16 

Total Volume (m3) 7353538,09 341218,15 591507,46 

mean Growth (m3/ha.year): high-range estimate 7,80 3,34 6,27 

mean Growth (m3/ha.year): mid-range estimate 5,99 2,57 4,81 

mean Growth (m3/ha.year): low estimate 4,95 2,12 3,98 

Carbon sequestration (T/ha.year): high-range estimate 3,70 1,59 2,98 

Carbon sequestration (T/year): mid-range estimate 2,85 1,22 2,29 

Carbon sequestration (T/ha.year): low-range estimate 2,35 1,01 1,89 

% of forest stands 88,01% 4,66% 7,33% 

 

Total road length within the living lab area (km) 1145,2 

Road length protected by protection forests (km) 92 

Percentage of roads protected by forest (%) 8,03% 
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5.4 LL3: Tegernsee Valley, Upper Bavaria 
The Tegernsee Valley Living Lab is composed of several forest parcels distributed across four geographical 
sectors. The map below shows these four sectors. 

To carry out the biophysical assessment of ecosystem services (FESs) within this Living Lab, we worked in 
two stages. The first stage was a testing phase conducted on one of the four geographical sectors, with 
results presented at the scale of the entire analysis area (a 4 × 5 km rectangle). The second stage consisted of 
defining an analysis perimeter using a 5 km buffer around the boundaries of the forest parcels. The results 
of these two stages are presented below. 

5.4.1 Results obtained for the test area 
• FES1: map of forest areas with high biodiversity and habitat support potential (support service) 

 



55 

D.2.2.1: FOREST ECOSYSTEM SERVICES ASSESSMENT PILOT ACTION REPORT 
 

• FES 2: map of volume standing timber (timber production service) 

 



56 

D.2.2.1: FOREST ECOSYSTEM SERVICES ASSESSMENT PILOT ACTION REPORT 
 

• FES3: map of carbon storage in forest areas (regulation service) 
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• FES4: map of protective forest against rockfall risks (regulation service) 

This living lab is not concerned by this FES. 

• FES 5: map of high visual interest (cultural service) 
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• FES 6: map of growing stock volume (regulation and support service) 
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• FES 7: map of growing stock volume increment (regulation and support service) 
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• Map of main forest stand types (supporting all FESs biophysical assessment) 
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• Synthesis table listing each FES with its associated indicator and value 
 
 
 

 Deciduous Coniferous Mixed 

Area total (ha) 933,91 4364,01 4299,36 

mean Carbon stored (T/ha) 210,20 215,53 215,14 

Total Carbon stored (T) 196306,67 940586,43 924955,50 

mean Volume (m3/ha) 851,99445 873,6099 872,0106 

Total Volume (m3) 795681,96 3812440,59 3749084,88 

mean Growth (m3/ha.year): high-range estimate 13,07529 16,14553 14,70067 

mean Growth (m3/ha.year): mid-range estimate 10,04 12,40 11,29 

mean Growth (m3/ha.year): low-range estimate 8,29 10,24 9,32 

Carbon sequestration (T/year): high estimate 6,21 7,67 6,98 

Carbon sequestration (T/year): mid-range estimate 4,77 5,89 5,36 

Carbon sequestration (T/year): low-range estimate 3,94 4,86 4,43 

% of forest stands 9,73% 45,47% 44,80% 

 

 Biodiversity Production Protective Tourism 

Area total (ha) 2996,11 9599,28 55,20 4822,08 

mean Carbon stored (T/ha) 135,28 203,16 193,40 204,62 

mean Volume (m3/ha) 548,34 823,47 783,91 829,38 

mean Growth (m3/ha.year): high-range estimate 14,52 16,96 16,93 16,97 

mean Growth (m3/ha.year): mid-range estimate 11,15 13,03 13,00 13,03 

mean Growth (m3/ha.year): low-range estimate 9,21 10,76 10,74 10,76 

Carbon sequestration (T/ha.year): high-range estimate 6,90 8,06 8,04 8,06 

Carbon sequestration (T/year): mid-range estimate 5,30 6,19 6,18 6,19 

Carbon sequestration (T/ha.year) : low-range estimate 4,37 5,11 5,10 5,11 

FES in % of the total forest area 31,21% 100,00% 0,58% 50,23% 
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BIODIVERSITE Deciduous Coniferous Mixed 

Area total (ha) 125,97 800,72 86,35 

mean Carbon stored (T/ha) 26,44 108,85 102,95 

Total Carbon stored (T) 3330,14 87158,30 8889,71 

mean Volume (m3/ha) 107,15 441,20 417,28 

Total Volume (m3) 13497,93 353275,23 36032,29 

mean Growth (m3/ha.year): high-range estimate 13,10 18,90 16,01 

mean Growth (m3/ha.year): mid-range estimate 10,06 14,52 12,30 

mean Growth (m3/ha.year): low estimate 8,31 11,99 10,15 

Carbon sequestration (T/ha.year): high-range estimate 6,22 8,98 7,60 

Carbon sequestration (T/year): mid-range estimate 4,78 6,90 5,84 

Carbon sequestration (T/ha.year): low-range estimate 3,95 5,69 4,82 

% of forest stands 12,43% 79,04% 8,52% 

 
 

 

PRODUCTION Deciduous Coniferous Mixed 

Area total (ha) 931,29 4363,59 4297,48 

mean Carbon stored (T/ha) 38,48 116,59 108,40 

Total Carbon stored (T) 35837,39 508730,42 465865,89 

mean Volume (m3/ha) 155,98 472,55 439,39 

Total Volume (m3) 145258,27 2062016,51 1888275,44 

mean Growth (m3/ha.year): high-range estimate 17,77 17,46 16,26 

mean Growth (m3/ha.year): mid-range estimate 13,65 13,41 12,49 

mean Growth (m3/ha.year): low estimate 11,27 11,07 10,32 

Carbon sequestration (T/ha.year): high-range estimate 8,44 8,29 7,73 

Carbon sequestration (T/year): mid-range estimate 6,48 6,37 5,93 

Carbon sequestration (T/ha.year): low-range estimate 5,35 5,26 4,90 

% of forest stands 9,71% 45,49% 44,80% 
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TOURISM Deciduous Coniferous Mixed 

Area total (ha) 760,80 3240,80 3409,83 

mean Carbon (T/ha) 3,81 109,23 97,75 

Total Carbon (T) 2897,45 353988,16 333305,01 

mean Volume (m3/ha) 15,44 442,73 396,20 

Total Volume (m3) 11744,12 1434805,98 1350971,80 

mean Growth (m3/ha.year): high-range estimate 4,02 9,10 7,65 

mean Growth (m3/ha.year): mid-range estimate 3,09 6,99 5,87 

mean Growth (m3/ha.year): low estimate 2,55 5,77 4,85 

Carbon sequestration (T/ha.year): high-range estimate 1,91 4,32 3,63 

Carbon sequestration (T/year): mid-range estimate 1,47 3,32 2,79 

Carbon sequestration (T/ha.year): low-range estimate 1,21 2,74 2,30 

% of forest stands 10,27% 43,73% 46,01% 
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5.4.2 Results obtained for the Living Lab 
• Map of the forest parcel location 

 

• FES1: map of forest areas with high biodiversity and habitat support potential (support service) 
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• FES 2: map of volume standing timber (timber production service) 
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• FES3: map of carbon storage in forest areas (regulation service) 
 



68 

D.2.2.1: FOREST ECOSYSTEM SERVICES ASSESSMENT PILOT ACTION REPORT 
 

• FES4: map of protective forest against rockfall risks (regulation service) 

This living lab is not concerned by this FES. 

• FES 5: map of high visual interest (cultural service) 
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• FES 6: map of growing stock volume (regulation and support service) 
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• FES 7: map of growing stock volume increment (regulation and support service) 
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• Map of main forest stand types (supporting all FESs biophysical assessment) 
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• Synthesis table listing each FES with its associated indicator and value 

 

 Deciduous Coniferous Mixed 

Area total (ha) 1963,12 18530,83 8867,99 

mean Carbon stored (T/ha) 205,35 212,94 209,07 

Total Carbon stored (T) 940586,43 196306,67 924955,50 

mean Volume (m3/ha) 832,3532 863,1136 847,4121 

Total Volume (m3) 3812440,59 795681,96 3749084,88 

mean Growth (m3/ha.year): high-range estimate 14,27104 15,60347 15,26148 

mean Growth (m3/ha.year): mid-range estimate 10,96 11,98 11,72 

mean Growth (m3/ha.year): low-range estimate 9,05 9,90 9,68 

Total Growth (m3/year) 28015,71 289145,25 135338,61 

Carbon sequestration (T/year): high estimate 6,78 7,41 7,25 

Carbon sequestration (T/year): mid-range estimate 5,21 5,69 5,57 

Carbon sequestration (T/year): low-range estimate 4,30 4,70 4,60 

% of forest stands 6,69% 63,11% 30,20% 

 

 Biodiversity Production Protective Tourism 

Area total (ha) 4015,62 31424,97 0,00 19092,04 

mean Carbon stored (T/ha) 192,54 210,31 0,00 210,38 

mean Volume (m3/ha) 780,41 852,46 0,00 852,73 

mean Growth (m3/ha.year): high-range estimate 18,00 15,86 0,00 15,45 

mean Growth (m3/ha.year): mid-range estimate 13,82 12,18 0,00 11,87 

mean Growth (m3/ha.year): low-range estimate 11,41 10,06 0,00 9,80 

Carbon sequestration (T/ha.year): high-range estimate 8,55 7,53 0,00 7,34 

Carbon sequestration (T/year): mid-range estimate 6,56 5,79 0,00 5,64 

Carbon sequestration (T/ha.year) : low-range estimate 5,42 4,78 0,00 4,66 

FES in % of the total forest area 12,78% 100,00% 0,00% 60,75% 
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BIODIVERSITE Deciduous Coniferous Mixed 

Area total (ha) 1408,32 446,85 1601,25 

mean Carbon stored (T/ha) 115,25 109,79 100,30 

Total Carbon stored (T) 162314,22 49060,46 160598,76 

mean Volume (m3/ha) 467,15 445,01 406,53 

Total Volume (m3) 657901,42 198854,79 650948,53 

mean Growth (m3/ha.year): high-range estimate 18,38 16,93 16,97 

mean Growth (m3/ha.year): mid-range estimate 14,12 13,01 13,04 

mean Growth (m3/ha.year): low estimate 11,66 10,74 10,77 

Total Growth (m3/year) 25883,98 7567,09 27179,63 

Carbon sequestration (T/ha.year): high-range estimate 8,73 8,04 8,06 

Carbon sequestration (T/year): mid-range estimate 6,70 6,18 6,19 

Carbon sequestration (T/ha.year): low-range estimate 5,54 5,10 5,11 

% of forest stands 40,75% 12,93% 46,33% 

 

PRODUCTION Deciduous Coniferous Mixed 

Area total (ha) 1961,35 18522,51 8863,39 

mean Carbon stored (T/ha) 119,60 157,99 94,26 

Total Carbon stored (T) 234582,42 35837,39 835463,60 

mean Volume (m3/ha) 484,78 640,36 382,06 

Total Volume (m3) 950823,55 11861140,14 3386350,95 

mean Growth (m3/ha.year): high-range estimate 17,17 15,38 16,88 

mean Growth (m3/ha.year): mid-range estimate 13,18 11,82 12,96 

mean Growth (m3/ha.year): low estimate 10,89 9,76 10,70 

Total Growth (m3/year) 33669,76 284954,48 149582,25 

Carbon sequestration (T/ha.year): high-range estimate 8,15 7,31 8,02 

Carbon sequestration (T/year): mid-range estimate 6,26 5,61 6,16 

Carbon sequestration (T/ha.year): low-range estimate 5,17 4,64 5,08 

% of forest stands 6,68% 63,11% 30,20% 
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TOURISM Deciduous Coniferous Mixed 

Area total (ha) 1224,85 11409,69 5318,98 

mean Carbon (T/ha) 120,03 158,23 94,57 

Total Carbon (T) 147020,80 1805333,92 503034,63 

mean Volume (m3/ha) 486,52 641,34 383,33 

Total Volume (m3) 595913,64 7317486,29 2038929,96 

mean Growth (m3/ha.year): high-range estimate 17,03 14,93 16,42 

mean Growth (m3/ha.year): mid-range estimate 13,08 11,47 12,61 

mean Growth (m3/ha.year): low estimate 10,80 9,47 10,42 

Total Growth (m3/year) 20858,77 170345,56 87342,54 

Carbon sequestration (T/ha.year): high-range estimate 4,32 1,91 3,63 

Carbon sequestration (T/year): mid-range estimate 6,21 5,45 5,99 

Carbon sequestration (T/ha.year): low-range estimate 5,13 4,50 4,95 

% of forest stands 6,82% 63,55% 29,63% 
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5.5 LL4: Styria 

5.5.1 Graz pilot area 
• FES1: map of forest areas with high biodiversity and habitat support potential (support service) 
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• FES 2: map of volume standing timber (timber production service) 
 



77 

D.2.2.1: FOREST ECOSYSTEM SERVICES ASSESSMENT PILOT ACTION REPORT 
 

• FES3: map of carbon storage in forest areas (regulation service) 
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• FES4: map of protective forest against rockfall risks (regulation service) 
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• FES 5: map of high visual interest (cultural service) 
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• FES 6: map of growing stock volume (regulation and support service) 
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• FES 7: map of growing stock volume increment (regulation and support service) 
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• Map of main forest stand types (supporting all FESs biophysical assessment) 
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• Synthesis table listing each FES with its associated indicator and value 
 

 

 Deciduous Coniferous Mixed 

Area total (ha) 19228,51 16071,08 32067,83 

mean Carbon stored (T/ha) 159,39 158,41 166,32 

Total Carbon stored (T) 3064860,49 2545869,60 5333608,07 

mean Volume (m3/ha) 646,054996 642,0894 674,1491 

Total Volume (m3) 12422676,89 10319070,11 21618498,73 

mean Growth (m3/ha.year): high-range estimate 11,2084322 15,557 12,96833 

mean Growth (m3/ha.year): mid-range estimate 8,61 11,95 9,96 

mean Growth (m3/ha.year): low-range estimate 7,11 9,87 8,23 

Carbon sequestration (T/year): high estimate 5,32 7,39 6,16 

Carbon sequestration (T/year): mid-range estimate 4,09 5,68 4,73 

Carbon sequestration (T/year): low-range estimate 3,38 4,69 3,91 

% of forest stands 28,54% 23,86% 47,60% 

 
 

 

 Biodiversity Production Protective Tourism 

Area total (ha) 221,77 67367,42 4935,44 48167,90 

mean Carbon stored (T/ha) 148,25 159,16 151,84 158,33 

mean Volume (m3/ha) 600,88 645,13 615,44 641,77 

mean Growth (m3/ha.year): high-range estimate 13,36 14,94 19,01 15,96 

mean Growth (m3/ha.year): mid-range estimate 10,26 11,47 14,60 12,26 

mean Growth (m3/ha.year): low-range estimate 8,47 9,47 12,06 10,12 

Carbon sequestration (T/ha.year): high-range estimate 6,34 7,09 9,03 7,58 

Carbon sequestration (T/year): mid-range estimate 4,87 5,45 6,94 5,82 

Carbon sequestration (T/ha.year) : low-range estimate 4,02 4,50 5,73 4,81 

FES in % of the total forest area 0,33% 100,00% 7,33% 71,50% 
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BIODIVERSITE Deciduous Coniferous Mixed 

Area total (ha) 159,55 4,37 51,96 

mean Carbon stored (T/ha) 97,56 150,51 137,92 

Total Carbon stored (T) 15564,97 658,31 7166,84 

mean Volume (m3/ha) 395,42 610,04 559,04 

Total Volume (m3) 63088,87 2668,32 29049,07 

mean Growth (m3/ha.year): high-range estimate 8,25 13,05 12,06 

mean Growth (m3/ha.year): mid-range estimate 6,34 10,02 9,26 

mean Growth (m3/ha.year): low estimate 5,23 8,28 7,65 

Carbon sequestration (T/ha.year): high-range estimate 3,92 6,20 5,73 

Carbon sequestration (T/year): mid-range estimate 3,01 4,76 4,40 

Carbon sequestration (T/ha.year): low-range estimate 2,49 3,93 3,63 

% of forest stands 73,90% 2,03% 24,07% 

 
 

 

PRODUCTION Deciduous Coniferous Mixed 

Area total (ha) 19067,97 16056,20 32009,59 

mean Carbon stored (T/ha) 79,27 100,96 112,69 

Total Carbon stored (T) 1511574,18 1620999,85 3607288,91 

mean Volume (m3/ha) 321,31 409,21 456,78 

Total Volume (m3) 6126802,86 6570333,46 14621278,83 

mean Growth (m3/ha.year): high-range estimate 12,93 17,36 14,92 

mean Growth (m3/ha.year): mid-range estimate 9,93 13,34 11,46 

mean Growth (m3/ha.year): low estimate 8,20 11,01 9,46 

Carbon sequestration (T/ha.year): high-range estimate 6,14 8,25 7,09 

Carbon sequestration (T/year): mid-range estimate 4,72 6,33 5,44 

Carbon sequestration (T/ha.year): low-range estimate 3,89 5,23 4,50 

% of forest stands 28,40% 23,92% 47,68% 
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PROTECTIVE Deciduous Coniferous Mixed 

Area total (ha) 1119,12 1042,44 2529,69 

mean Carbon (T/ha) 90,49 91,72 138,09 

Total Carbon (T) 101270,23 95613,49 349313,51 

mean Volume (m3/ha) 366,78 371,77 559,70 

Total Volume (m3) 410474,54 387546,35 1415858,40 

mean Growth (m3/ha.year): high-range estimate 17,16 17,43 12,55 

mean Growth (m3/ha.year): mid-range estimate 13,18 13,39 9,64 

mean Growth (m3/ha.year): low estimate 10,88 11,06 7,96 

Carbon sequestration (T/ha.year): high-range estimate 8,15 8,28 5,96 

Carbon sequestration (T/year): mid-range estimate 6,26 6,36 4,58 

Carbon sequestration (T/ha.year): low-range estimate 5,17 5,25 3,78 

% of forest stands 23,86% 22,22% 53,92% 

 

TOURISM Deciduous Coniferous Mixed 

Area total (ha) 13822,77 11564,51 22755,44 

mean Carbon (T/ha) 76,07 99,48 109,84 

Total Carbon (T) 1051498,64 1150380,07 2499530,26 

mean Volume (m3/ha) 308,33 403,20 445,22 

Total Volume (m3) 4261997,23 4662789,49 10131245,38 

mean Growth (m3/ha.year): high-range estimate 14,38 17,45 16,51 

mean Growth (m3/ha.year): mid-range estimate 11,05 13,40 12,68 

mean Growth (m3/ha.year): low estimate 9,12 11,07 10,47 

Carbon sequestration (T/ha.year): high-range estimate 6,83 8,29 7,84 

Carbon sequestration (T/year): mid-range estimate 5,25 6,37 6,02 

Carbon sequestration (T/ha.year): low-range estimate 4,33 5,26 4,97 

% of forest stands 28,71% 24,02% 47,27% 

 

Total road length within the living lab area (km) 6142,7 

Road length protected by protection forests (km) 111,1 

Percentage of roads protected by forest (%) 1,81% 
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5.5.2 Thannhausen pilot area 
• FES1: map of forest areas with high biodiversity and habitat support potential (support service) 
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• FES 2: map of volume standing timber (timber production service) 
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• FES3: map of carbon storage in forest areas (regulation service) 
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• FES4: map of protective forest against rockfall risks (regulation service) 
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• FES 5: map of high visual interest (cultural service) 
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• FES 6: map of growing stock volume (regulation and support service) 
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• FES 7: map of growing stock volume increment (regulation and support service) 
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• Map of main forest stand types (supporting all FESs biophysical assessment) 
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• Synthesis table listing each FES with its associated indicator and value 
 

 Deciduous Coniferous Mixed 

Area total (ha) 157,43 287,79 1429,75 

mean Carbon stored (T/ha) 191,05 179,30 175,63 

Total Carbon stored (T) 30076,86 51600,93 251104,97 

mean Volume (m3/ha) 774,37 726,75 711,87 

Total Volume (m3) 121909,33 209151,98 1017793,43 

mean Growth (m3/ha.year): high-range estimate 11,44 15,72 11,67 

mean Growth (m3/ha.year): mid-range estimate 8,79 12,08 8,97 

mean Growth (m3/ha.year): low-range estimate 7,26 9,97 7,41 

Total Growth (m3/year) 1801,57 4524,90 16691,59 

Carbon sequestration (T/year): high estimate 5,44 7,47 5,55 

Carbon sequestration (T/year): mid-range estimate 4,17 5,74 4,26 

Carbon sequestration (T/year): low-range estimate 3,45 4,74 3,52 

% of forest stands 8,40% 15,35% 76,25% 

 

 Biodiversity Production Protective Tourism 

Area total (ha) 204,97 2126,66 76,35 1767,83 

mean Carbon stored (T/ha) 164,97 169,44 166,70 170,85 

mean Volume (m3/ha) 668,66 686,77 675,66 692,49 

mean Growth (m3/ha.year): high-range estimate 9,30 11,56 12,71 12,22 

mean Growth (m3/ha.year): mid-range estimate 7,14 8,88 9,76 9,39 

mean Growth (m3/ha.year): low-range estimate 5,90 7,33 8,06 7,75 

Carbon sequestration (T/ha.year): high-range estimate 4,42 5,49 6,04 5,81 

Carbon sequestration (T/year): mid-range estimate 3,39 4,22 4,64 4,46 

Carbon sequestration (T/ha.year) : low-range estimate 2,80 3,48 3,83 3,68 

FES in % of the total forest area 9,64% 100,00% 3,59% 83,13% 

 

BIODIVERSITE Deciduous Coniferous Mixed 

Area total (ha) 24,89 5,48 121,10 

mean Carbon stored (T/ha) 75,35 113,68 129,81 

Total Carbon stored (T) 1875,78 623,41 15718,91 

mean Volume (m3/ha) 305,41 305,41 526,13 

Total Volume (m3) 7603,04 1674,88 63712,81 

mean Growth (m3/ha.year): high-range estimate 8,13 8,13 10,12 

mean Growth (m3/ha.year): mid-range estimate 6,25 6,25 7,77 

mean Growth (m3/ha.year): low estimate 5,16 5,16 6,42 

Total Growth (m3/year) 202,44 44,60 1225,73 

Carbon sequestration (T/ha.year): high-range estimate 3,86 3,86 4,81 

Carbon sequestration (T/year): mid-range estimate 2,97 2,97 3,69 

Carbon sequestration (T/ha.year): low-range estimate 2,45 2,45 3,05 
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% of forest stands 16,43% 3,62% 79,94% 

 

PRODUCTION Deciduous Coniferous Mixed 

Area total (ha) 10,65 18,66 1427,03 

mean Carbon stored (T/ha) 67,29 110,91 132,98 

Total Carbon stored (T) 716,71 2069,48 189770,72 

mean Volume (m3/ha) 272,75 321,31 456,78 

Total Volume (m3) 2905,00 5995,53 651838,16 

mean Growth (m3/ha.year): high-range estimate 14,84 12,93 14,92 

mean Growth (m3/ha.year): mid-range estimate 11,40 9,93 11,46 

mean Growth (m3/ha.year): low estimate 9,41 8,20 9,46 

Total Growth (m3/year) 158,06 241,22 21291,59 

Carbon sequestration (T/ha.year): high-range estimate 7,05 6,14 7,09 

Carbon sequestration (T/year): mid-range estimate 5,41 4,72 5,44 

Carbon sequestration (T/ha.year): low-range estimate 4,47 3,89 4,50 

% of forest stands 0,73% 1,29% 97,99% 

 

TOURISM Deciduous Coniferous Mixed 

Area total (ha) 141,13 259,28 1173,01 

mean Carbon (T/ha) 68,66 111,23 133,61 

Total Carbon (T) 9690,50 1051498,64 156725,64 

mean Volume (m3/ha) 450,83 308,33 541,56 

Total Volume (m3) 63627,92 4261997,23 635249,92 

mean Growth (m3/ha.year): high-range estimate 14,76 14,38 12,05 

mean Growth (m3/ha.year): mid-range estimate 11,34 11,05 9,26 

mean Growth (m3/ha.year): low estimate 9,36 9,12 7,65 

Total Growth (m3/year) 2083,02 198795,23 14138,74 

Carbon sequestration (T/ha.year): high-range estimate 7,01 6,83 5,73 

Carbon sequestration (T/year): mid-range estimate 5,38 5,25 4,40 

Carbon sequestration (T/ha.year): low-range estimate 4,45 4,33 3,63 

% of forest stands 8,97% 28,71% 74,55% 
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PROTECTIVE Deciduous Coniferous Mixed 

Area total (ha) 10,65 18,66 41,34 

mean Carbon (T/ha) 41,99 123,90 74,13 

Total Carbon (T) 447,26 101270,23 3064,66 

mean Volume (m3/ha) 170,21 502,20 122,31 

Total Volume (m3) 1812,86 410474,54 5056,69 

mean Growth (m3/ha.year): high-range estimate 16,52 10,96 12,55 

mean Growth (m3/ha.year): mid-range estimate 12,69 13,18 11,53 

mean Growth (m3/ha.year): low estimate 10,48 10,88 7,96 

Total Growth (m3/year) 175,97 19202,96 518,73 

Carbon sequestration (T/ha.year): high-range estimate 7,85 8,15 5,96 

Carbon sequestration (T/year): mid-range estimate 6,03 6,26 5,48 

Carbon sequestration (T/ha.year): low-range estimate 4,98 5,17 3,78 

% of forest stands 15,07% 23,86% 58,52% 
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5.6 LL5: Karavanke Mountains, municipality Tržič 
• FES1: map of forest areas with high biodiversity and habitat support potential (support service) 
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• FES2: map of volume standing timber (timber production service) 
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• FES3: map of carbon storage in forest areas (regulation service) 
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• FES4: map of protective forest (regulation service) 

o Protective forest against rockfalls 
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o Forest area of high relevance for river/torrent bank stabilization 
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o Forest area of high relevance for protection against torrential risks 
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• FES 5: map of high visual interest (cultural service) 
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• FES 6: map of growing stock volume (regulation and support service) 
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• FES 7: map of growing stock volume increment (regulation and support service) 
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• Map of main forest stand types (supporting all FESs biophysical assessment) 
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• Synthesis table listing each FES with its associated indicator and value 
 

 Deciduous Coniferous Mixed 

Area total (ha) 1704,49 5494,39 4630,29 

mean Carbon stored (T/ha) 131,97 135,33 137,83 

Total Carbon stored (T) 224944,34 743538,77 638187,26 

mean Volume (m3/ha) 534,92 548,52 558,66 

Total Volume (m3) 911757,88 3013755,33 2586738,19 

mean Growth (m3/ha.year): high-range estimate 15,83 17,93 18,32 

mean Growth (m3/ha.year): mid-range estimate 12,15 13,77 14,07 

mean Growth (m3/ha.year): low-range estimate 10,04 11,37 11,62 

Carbon sequestration (T/year): high estimate 7,52 8,52 8,70 

Carbon sequestration (T/year): mid-range estimate 5,77 6,54 6,68 

Carbon sequestration (T/year): low-range estimate 4,77 5,40 5,52 

% of forest stands 14,41% 46,45% 39,14% 

 

 Biodiversity Production Tourism 

Area total (ha) 10414,44 11829,17 4414,47 

mean Carbon stored (T/ha) 136,28 136,96 137,44 

mean Volume (m3/ha) 552,37 555,15 557,08 

mean Growth (m3/ha.year): high-range estimate 20,40 16,96 18,08 

mean Growth (m3/ha.year): mid-range estimate 15,67 13,03 13,88 

mean Growth (m3/ha.year): low-range estimate 12,94 10,76 11,47 

Carbon sequestration (T/ha.year): high-range estimate 9,69 8,06 8,59 

Carbon sequestration (T/year): mid-range estimate 7,44 6,19 6,59 

Carbon sequestration (T/ha.year) : low-range estimate 6,15 5,11 5,45 

FES in % of the total forest area 88,04% 100,00% 37,32% 

 

 
Protective 
(rockfalls) 

Protective (torrents 
woody debris) 

Area total (ha) 1180,25 2804,75 

mean Carbon stored (T/ha) 125,78 105,51 

mean Volume (m3/ha) 509,84 427,67 

mean Growth (m3/ha.year): high-range estimate 19,43 19,52 

mean Growth (m3/ha.year): mid-range estimate 14,92 14,99 

mean Growth (m3/ha.year): low-range estimate 12,33 12,38 

Carbon sequestration (T/ha.year): high-range estimate 9,23 9,27 

Carbon sequestration (T/year): mid-range estimate 7,09 7,12 

Carbon sequestration (T/ha.year) : low-range estimate 5,85 5,88 

FES in % of the total forest area 9,98% 23,71% 
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BIODIVERSITE Deciduous Coniferous Mixed 

Area total (ha) 1439,95 4987,51 3986,98 

mean Carbon stored (T/ha) 61,12 100,91 85,58 

Total Carbon stored (T) 88012,19 503296,94 341199,23 

mean Volume (m3/ha) 247,74 409,02 346,87 

Total Volume (m3) 356736,28 2039993,20 1382969,08 

mean Growth (m3/ha.year): high-range estimate 18,13 20,93 20,77 

mean Growth (m3/ha.year): mid-range estimate 13,92 16,08 15,95 

mean Growth (m3/ha.year): low estimate 11,50 13,28 13,17 

Carbon sequestration (T/ha.year): high-range estimate 8,61 9,94 9,87 

Carbon sequestration (T/year): mid-range estimate 6,61 7,64 7,58 

Carbon sequestration (T/ha.year): low-range estimate 5,46 6,31 6,26 

% of forest stands 13,83% 47,89% 38,28% 

 
 

 

PRODUCTION Deciduous Coniferous Mixed 

Area total (ha) 1644,31 5488,83 4623,53 

mean Carbon stored (T/ha) 63,46 96,88 88,16 

Total Carbon stored (T) 104354,81 531774,46 407605,82 

mean Volume (m3/ha) 257,24 392,69 357,33 

Total Volume (m3) 422977,14 2155420,08 1652132,26 

mean Growth (m3/ha.year): high-range estimate 17,31 19,71 20,10 

mean Growth (m3/ha.year): mid-range estimate 13,29 15,14 15,44 

mean Growth (m3/ha.year): low estimate 10,98 12,50 12,75 

Carbon sequestration (T/ha.year): high-range estimate 8,22 9,36 9,55 

Carbon sequestration (T/year): mid-range estimate 6,31 7,19 7,33 

Carbon sequestration (T/ha.year): low-range estimate 5,22 5,94 6,06 

% of forest stands 13,99% 46,69% 39,33% 
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PROTECTIVE rockfalls Deciduous Coniferous Mixed 

Area total (ha) 112,61 215,68 757,36 

mean Carbon (T/ha) 61,80 78,03 97,99 

Total Carbon (T) 6958,69 16829,45 74213,85 

mean Volume (m3/ha) 250,48 316,28 397,18 

Total Volume (m3) 28205,40 68214,15 300808,01 

mean Growth (m3/ha.year): high-range estimate 17,38 17,07 20,78 

mean Growth (m3/ha.year): mid-range estimate 13,35 13,11 15,96 

mean Growth (m3/ha.year): low estimate 11,03 10,83 13,18 

Total Growth (m3/year) 1957,38 3681,67 15741,29 

Carbon sequestration (T/ha.year): high-range estimate 8,26 8,11 9,87 

Carbon sequestration (T/year): mid-range estimate 6,34 6,23 7,58 

Carbon sequestration (T/ha.year): low-range estimate 5,24 5,14 6,26 

% of forest stands 10,37% 19,87% 69,76% 

 

Total road length within the living lab area (km) 307 

Road length protected by protection forests (km) 22,4 

Percentage of roads protected by forest (%) 7,30% 
 
 

 

PROTECTIVE (torrents woody debris) Deciduous Coniferous Mixed 

Area total (ha) 733,18 1773,30 1907,99 

mean Carbon (T/ha) 101,56 96,24 85,95 

Total Carbon (T) 74463,43 170658,62 163982,89 

mean Volume (m3/ha) 411,66 390,08 348,36 

Total Volume (m3) 301819,64 691723,74 664665,27 

mean Growth (m3/ha.year): high-range estimate 12,97 19,79 20,22 

mean Growth (m3/ha.year): mid-range estimate 9,96 15,20 15,53 

mean Growth (m3/ha.year): low estimate 8,23 12,56 12,82 

Carbon sequestration (T/ha.year): high-range estimate 6,16 9,40 9,60 

Carbon sequestration (T/year): mid-range estimate 4,73 7,22 7,38 

Carbon sequestration (T/ha.year): low-range estimate 3,91 5,96 6,09 

% of forest stands 16,61% 40,17% 43,22% 
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PROTECTIVE Torrential risk: total forested concerned area 
(TFCA) 

Deciduous Coniferous Mixed 

Area total (ha) 213,89 3657,23 3472,60 

mean Carbon (T/ha) 25,47 94,05 88,68 

Total Carbon (T) 5446,84 343952,45 307942,00 

mean Volume (m3/ha) 103,22 381,20 359,43 

Total Volume (m3) 22077,45 1394128,62 1248168,95 

mean Growth (m3/ha.year): high-range estimate 20,32 20,56 20,21 

mean Growth (m3/ha.year): mid-range estimate 15,61 15,79 15,52 

mean Growth (m3/ha.year): low estimate 12,89 13,04 12,82 

Total Growth (m3/year) 4346,79 75206,06 70169,88 

Carbon sequestration (T/ha.year): high-range estimate 9,65 9,77 9,60 

Carbon sequestration (T/year): mid-range estimate 7,41 7,50 7,37 

Carbon sequestration (T/ha.year): low-range estimate 6,12 6,20 6,09 

% of forest stands 2,91% 49,80% 47,29% 

 
 

 

PROTECTIVE Torrential risk: Min PFE Deciduous Coniferous Mixed 

Area total (ha) 112,61 215,68 757,36 

mean Carbon (T/ha) 61,80 78,03 97,99 

Total Carbon (T) 6958,69 16829,45 74213,85 

mean Volume (m3/ha) 250,48 316,28 397,18 

Total Volume (m3) 28205,40 68214,15 300808,01 

mean Growth (m3/ha.year): high-range estimate 17,38 17,07 20,78 

mean Growth (m3/ha.year): mid-range estimate 13,35 13,11 15,96 

mean Growth (m3/ha.year): low estimate 11,03 10,83 13,18 

Total Growth (m3/year) 1957,38 3681,67 15741,29 

Carbon sequestration (T/ha.year): high-range estimate 8,26 8,11 9,87 

Carbon sequestration (T/year): mid-range estimate 6,34 6,23 7,58 

Carbon sequestration (T/ha.year): low-range estimate 5,24 5,14 6,26 

% of forest stands 10,37% 19,87% 69,76% 
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PROTECTIVE Torrential risk: Max PFE Deciduous Coniferous Mixed 

Area total (ha) 3,37 362,88 184,21 

mean Carbon (T/ha) 25,47 75,30 36,23 

Total Carbon (T) 85,73 27324,04 6673,46 

mean Volume (m3/ha) 103,22 305,20 146,84 

Total Volume (m3) 347,49 110751,43 27049,25 

mean Growth (m3/ha.year): high-range estimate 5,69 21,00 4,62 

mean Growth (m3/ha.year): mid-range estimate 4,37 16,13 3,55 

mean Growth (m3/ha.year): low estimate 3,61 13,32 2,93 

Total Growth (m3/year) 19,16 7619,88 851,79 

Carbon sequestration (T/ha.year): high-range estimate 2,70 9,97 2,20 

Carbon sequestration (T/year): mid-range estimate 2,08 7,66 1,69 

Carbon sequestration (T/ha.year): low-range estimate 1,71 6,33 1,39 

% of forest stands 0,61% 65,92% 33,47% 
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5.7 Validation of large-scale biophysical assessments of FES using locally 
available data 

 
Several studies have been conducted for evaluating the robustness of our large-scale results by 
comparing them with local and national data. 

For Germany, published annual increment values range from 9.4 to 11.2 m³/ha·yr. This aligns well with 
the low- and mid-range evaluations (test site [9.64; 11.67], the entire living lab [9.76; 11.84]), with error 
rates of : for the test site +2.56% and +4.23%, respectively, and for the entire Living Lab +3.99% and 

+5.67%, respectively. 

For Slovenia, published increments range from 7.4 to 7.9 m³/ha.yr, consistent with the very low- and low-
range evaluations (8.18 m³/ha.yr). The error rates at the bounds are +3.50% and +10.50%; we therefore 
recommend using the very low-range estimate. 

In Austria, the published annual increment for production forests is 11.89 m³/ha.yr, close to the mid-range 
estimate of 11.47 m³/ha.yr (error rate: -3.53%) for the Graz pilot area (total area of 67367.42 ha) and close 
to the high-range estimate of 11.56 m³/ha.yr (error rate: -2.78%) for the Thannhausen pilot area (total area 
of 1874,97 ha). 

For Italian broadleaf forests, reported data indicate an average increment of 6 m³/ha.yr and a mean volume 
of 200–500 m³/ha for beech forests, and 8 m³/ha.yr with 200–400 m³/ha for chestnut forests. These values 
agree with the high-range evaluation (7.5 m³/ha.yr; 429.4 m³/ha) for all broadleaf stands combined. 

In France, the National Forest Office conducted a dendrometric inventory using very high-resolution LiDAR 
(≈10 points/m²) to produce a 20×20 m grid inventory map. In the Grand Annecy area, the total mean 
volume per hectare for all stand types is 340.47 m³/ha, compared with 339.18 m³/ha from LiDAR data 
(error: 0.38%). The published mean annual increment is 5.4 m³/ha.yr, close to the high-range estimate of 
5.11 m³/ha.yr (error: 5.41%). 
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Finally, comparing the protection forest map with the Natural Hazards Prevention Plan (PPRn) map 
showed that the large-scale data accurately identifies the same most exposed area as that the ones 
covered by the PPRn. 
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In conclusion, given the quality of the input data used, it is possible to determine the most robust type of 
estimation to apply for each country. For France and Italy, the high-range estimation is recommended; for 
Germany and Austria, the mid-range evaluation is suggested; and for Slovenia, the very low-range 
estimation should be used. This variation in estimation type follows a west-to-east geographical gradient, 
which very likely reflects a drift in the quality of the satellite data. 
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Appendix 1: How to assess torrential hazard protection forest 
ecosystem service? 
The methodology proposed and implemented in the Forest EcoValue project 

 
River systems represent a primary source of natural hazards, with flooding being the dominant process. 
Assessing flood-related risks requires an accurate mapping of waterways, which necessitates detailed field 
surveys to ensure reliable representation of the river network. 

Flood events are typically catastrophic in nature; however, they may both trigger and be triggered by other 
hazard processes, or act in combination with additional risks. In this study, a multi-hazard framework was 
therefore adopted. 

As a first step, avalanche paths terminating in river channels were mapped. Potential avalanche release 
areas were defined based on expert judgment. Using these expert-based release zones, avalanche 
propagation was simulated with the FlowPy model (freely available via 
https://docs.avaframe.org/en/latest/), in combination with a Digital Elevation Model (DEM) and forest 
cover maps. The simulations identified locations where avalanches may reach river channels and potentially 
form temporary dams. The sudden failure of such dams could generate impulse waves, thereby increasing 
flood hazard. In addition, avalanche debris transported within the river channel may contribute to the 
formation of logs jam, particularly at bridges and other hydraulic structures. 

The transport of large woody debris by rivers during flood events constitutes an additional source of 
hazard. To address this process, a Python-based buffering tool, to be integrated by April 2026 into the Web-
atlas of the Interreg Alpine Space project MOSAIC, was developed to delineate areas where trees may 
represent a potential source of large-woody debris recruitment during catastrophic floods. The underlying 
assumption is that trees likely to be mobilized originate predominantly from upslope areas within a 
distance proportional to their height. Default threshold distances are set to 20 m upslope (high-probability 
source areas, corresponding to the average tree height in the study area) and 40 m upslope (lower-
probability source areas). These distances are fully user-configurable. The tool integrates the user-selected 
river network with a DEM to compute true terrain-based (on-slope) distances, thereby accounting for 
topographic gradients and avoiding the limitations inherent to simple planimetric buffer approaches. 

Finally, the impact of flooding itself may be mitigated by forest cover. A first-order proxy for this 
attenuation effect was assessed using the mass-movement model currently under development, 
MASSMOV. The model was applied using the upstream points (springs) of rivers and streams as initiation 
data for the propagation area, and under three contrasting scenarios: 

1. No forest effect, with no additional friction applied; 
2. Moderate forest effect, corresponding to 50% efficiency and representative of average observed 

friction values; 

3. Maximum forest effect, corresponding to the highest friction values reported in the literature. 

For a study site, the identification of upstream points can be carried out through field inventory work 
and/or by using the drainage basin outlines associated with each of the identified and mapped streams. 
This work of defining the drainage basins is greatly facilitated by the use of a GIS. Two step-by-step guides 
for using QGIS are provided below 

https://docs.avaframe.org/en/latest/)
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Massmov - Gravitational mass movement propagation model 

1. GENERAL OVERVIEW 
MASSMOV is a modeling system developed to simulate the propagation of gravitational mass movements 
(avalanches and rockfalls) on three-dimensional terrain. The model uses a numerical approach based on 
topographic analysis and propagation profile characterization to predict potential impact zones of these 
hazardous natural phenomena. 

2. MODEL OBJECTIVES 
The model aims to: 

• Simulate the spatial propagation of gravitational mass movements from defined initiation points 

• Determine potential impact zones (reachable areas) 

• Calculate risk indicators based on geomorphological criteria 

• Produce regulatory zoning maps (red, blue, and white zones) 

• Enable batch processing for simultaneous analysis of multiple sites 

3. INPUT DATA 
The model relies on three main types of data: 

3.1. Digital Elevation Model (DEM) 

• Format: Georeferenced GeoTIFF 

• Raster representation of topography (regular grid of elevations) 

• Variable resolution adapted to the study scale 

3.2. Starting Points 

• Format: GeoPackage (GPKG) containing geographic coordinates (X, Y) 

• Define initiation zones for gravitational movements 

• Can represent avalanche sites or rockfall source areas 

3.3. Reference Table 

• Format: Excel (.xlsx) 

• Contains pairs of values (AAinf, ALE_max) defining propagation conditions 

• Established empirically from field observations and documented events 

4. PROPAGATION ALGORITHM 
The core of the model is based on a step-by-step propagation algorithm using a Breadth-First Search (BFS) 
approach. 

4.1. General Principle 

1. Initialization at the starting point (coordinates X, Y) 

2. Iterative exploration of the 8 adjacent neighbouring cells 
3. Calculation of geomorphological indicators for each candidate cell 

4. Comparison with the reference table to decide on propagation continuation 

5. Progressive construction of the reachable impact zone 

4.2. Calculated Indicators 

For each candidate cell for propagation, two main indicators are calculated from the topographic profile 
connecting the starting point to the cell: 
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Where: 

•Δz = elevation at starting point - minimum elevation of profile (total elevation drop) 

•d = total horizontal distance travelled 

Normalized Area Below (AAinf): 
 

Where the profile is normalized: 
 

The area is calculated using the trapezoidal method. 

4.3. Propagation Condition 

For each candidate cell: 

1. Calculate AAinf and ALE 

2. Search in the reference table: identify the largest value AAinf_ref ≤ AAinf 

3. Retrieve the corresponding ALE_max value 

4. Decision: If ALE ≤ ALEmax → propagation continues, otherwise → stop 

4.4. Distance Management 

The model accounts for the actual geometry of the grid: 

• Orthogonal neighbours (up/down/left/right): distance = DEM resolution 

• Diagonal neighbours: distance = resolution × √2 

5. RESULTS AND EXPORTS 

• Format: Georeferenced GeoTIFF 

• Binary or percentile value raster indicating reachable areas 



118 

D.2.2.1: FOREST ECOSYSTEM SERVICES ASSESSMENT PILOT ACTION REPORT 
 

STEP-BY-STEP: Watershed Delineation in QGIS 

1. Concepts 
A watershed (also named drainage basin) is calculated from: 

• a Digital Elevation Model (DEM) 

• flow direction derived from terrain 

• an outlet point (where water exits the basin) 

QGIS uses hydrological tools (GRASS or SAGA) to perform this analysis. 

Required data and tools 

• DEM (SRTM, ALOS, LiDAR, etc.) 

• QGIS 3.x 

• GRASS GIS tools (included in QGIS) 

2. Step 1: Load the Digital Elevation Model (DEM) 

1. Open QGIS 

2. Go to Layer → Add Layer → Add Raster Layer 

3. Load your DEM file 

Check CRS 

• Bottom-right corner → click CRS 

• Use a projected CRS (e.g., UTM), not geographic (lat/long) 

3. Step 2: Fill Sinks (Remove Depressions) 
This ensures continuous water flow. 

1. Open Processing Toolbox 

2. Navigate to: 
GRASS → Raster → Hydrology → r.fill.dir 

3. Set: 
a. Input raster: DEM 

b. Filled DEM: output file 
c. Flow direction: output file 

4. Click Run 

5. Outputs: 

a. Sink-filled DEM 

b. Flow direction raster 

4. Step 3: Compute Flow Accumulation and Direction 

1. In Processing Toolbox, open: GRASS → Raster → Hydrology → r.watershed 

2. Set: Elevation: Filled DEM 
3. Click Run 

4. Outputs: 

a. Flow accumulation 

b. Flow direction 

Tip: High accumulation values represent stream channels. 

5. Step 4: Identify and Create the Outlet Point 

1. Right-click Layers Panel → Create Layer → New Shapefile Layer 

2. Geometry type: Point 
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3. Save the layer 

4. Toggle Edit Mode 

5. Place a point: 

a. On the main stream 
b. At the lowest point of the basin 

6. Save edits and stop editing 

6. Step 5: Delineate the Watershed 

1. Open Processing Toolbox 
2. Go to: 

3. Set: 
GRASS → Raster → Hydrology → r.water.outlet 

a. Input flow direction: from Step 3 

b. Outlet point coordinates: 
Use the outlet point layer 

4. Click Run 

5. Output: Watershed raster 

7. Step 6: Convert Watershed Raster to Polygon 
1. Go to 

Raster → Conversion → Polygonize (Raster to Vector) 

2. Input: watershed raster 

3. Output: polygon layer 

Result: 

• Watershed boundary as a vector polygon 

8. Step 7: Calculate Watershed Area 

1. Open polygon attribute table 

2. Click Field Calculator 

3. Create new field: 

a. Name: Area_km2 
b. Type: Decimal 

4. Expression: $area / 1000000 

9. Optional Steps 

• Extract Stream Network 

a. Use r.watershed accumulation threshold 

b. Convert raster stream to vector 

• Create Sub-basins 

a. Use multiple outlet points 

b. Run r.water.outlet for each point 

10. Common Errors to Avoid 

• Outlet not placed on stream 

• DEM not filled 

• Wrong CRS 

• Low-resolution DEM 
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General workflow for Watershed Delineation in QGIS 
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Alternative (Simpler) STEP-BY-STEP: Watershed Delineation in QGIS + SAGA GIS 

1. Step 1: Load the DEM 

1. Open QGIS 3.x 

2. Go to Layer → Add Layer → Add Raster Layer 

3. Load your DEM 

4. Check CRS 

a. Ensure the CRS is projected (e.g., UTM), not geographic. 

2. Step 2: Fill Sinks (Depression Filling) 
Removes depressions in the DEM for proper flow analysis. 

1. Open Processing Toolbox 

2. Navigate to: SAGA → Terrain Analysis – Preprocessing → Fill sinks (Wang & Liu) 

3. Input: 

a. Elevation: DEM 

4. Output: 
a. filled DEM 

5. Click Run 

Result: a hydrologically corrected DEM 

3. Step 3: Compute Flow Direction 

1. Open Processing Toolbox → SAGA → Terrain Analysis – Preprocessing → Fill sinks (Wang & Liu) 

2. Input: 
a. Elevation: Filled DEM 

3. Outputs: 

a. Flow accumulation raster 

b. Flow direction raster 

4. Click Run 

Flow accumulation highlights streams. 

4. Step 4: Create the Outlet Point 

1. Layer → Create Layer → New Shapefile Layer 

2. Geometry type: Point 
3. Save the layer 

4. Toggle Edit Mode 

5. Place the point: 
a. On the main stream 

b. At the lowest elevation 

6. Save edits and stop editing 

5. Step 5: Delineate the Watershed 

1. Processing Toolbox →SAGA → Terrain Analysis – Hydrology → Watershed Basins 

2. Input parameters 

a. Flow direction: from Step 3 

b. Outlets: outlet point layer from Step 4 

3. Click Run 

Output: 

• Watershed raster (drainage basin) 
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6. Step 6: Convert Watershed Raster to Polygon 

1. Go to Raster → Conversion → Polygonize (Raster to Vector) 

2. Input: watershed raster 

3. Output: polygon layer 

Result: vector boundary of the drainage basin 

7. Step 7: Calculate Basin Area 

1. Open the polygon attribute table 

2. Click Field Calculator 
3. Create a new field: Area_km2 

4. Expression: $area / 1000000 

Tips & Common Errors 

• Place the outlet point on the stream 

• Always fill sinks before flow calculation 

• Ensure projected CRS 

• Use high-resolution DEM if possible 

Advantages of SAGA Method 

• Easier than GRASS 

• Faster workflow 

• Ideal for small–medium basins 

Disadvantage of SAGA method 
• Slightly less control than GRASS for complex terrains 



123 

D.2.2.1: FOREST ECOSYSTEM SERVICES ASSESSMENT PILOT ACTION REPORT 
 

 

General workflow for Watershed Delineation in QGIS using SAGA GIS toolbox 
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Appendix 2: Additional indicators beyond those used and usable at the 
local scale (specific field inventories, use of available field inventory 
data) 

Timber indicators 
Timber volume harvested 

Definition: Total annual volume of timber harvested from a stand (TVHtotal). This base metric aggregates the 
volume of timber harvested across all tree species and all diameter classes. 

Units: m3ha-1yr-1. 

Timber volume harvestedby speciesand diameter class 

Definition: Total annual volume of harvested timber separated by species and diameter class (TVHspecies, 

DBH). 

Units: m3ha-1yr-1. 

Productivity 

Definition: Current annual volume increment per hectare (VI). 

Units: m3ha-1yr-1. 

Stocking 

Definition: Stocking volume per hectare of living trees (V). Units: 

m3ha-1 

Timber yield by assortment 

Definition: Harvested timber by assortments (diameter, length) of round wood and industrial wood by 
species (HTA). 
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Carbon Storage 
Above ground carbon 

Definition: Dry mass of carbon contained in above ground living tree biomass (bole + branches + leaves; 
living trees). 

Units: t ha-1. 

Cabove = BMabove*CF 

where BMabove is the above ground forest biomass (t. ha-1) and CF is the carbon fraction of dry matter (t 
C * t d.m.-1) given for broad-leaves or conifers (Table 1). 

Table 1: Dry carbon fraction values 
 

 
Tree type Carbon dry fraction (CF) 

Broad-leaf 0.48 

Conifer 0.51 

Default 0.50 

 
Wood volume (m3 ha-1) method 

Above ground carbon stock is calculated using wood volume by first converting wood volume into above 
ground biomass (IPCC 2006): 

 

 
where V is timber volume (m3ha-1), D is the wood density (t dry matter m-3, Table 2), BEF is the biomass 
expansion factor for conversion of volume to above ground tree biomass (Table 3), and CF is the carbon 
fraction of dry matter (t C * t d.m.-1) given for broad-leaves or conifers (Table 1). 

Table 2: Wood densities of stemwood (tonnes dry matter/m3 fresh volume) 
 

Species or genus Wood density (D) 

Abies 0.40 

Acer 0.52 

Alnus 0.45 

Betula 0.51 

Carpinus betulus 0.63 

Castanea sativa 0.48 

Fagus sylvatica 0.58 

Fraxinus 0.57 

Juglans 0.53 

Larix decidua 0.46 

Larix kaempferi 0.49 

Picea abies 0.40 

Picea sitchensis 0.40 

Pinus pinaster 0.44 

Pinus strobus 0.32 

Pinus sylvestris 0.42 
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Populus 0.35 

Prunus 0.49 

Pseudotsuga menziesii 0.45 

Quercus 0.58 

Salix 0.45 

Thuja plicata 0.31 

Tilia 0.43 

Tsuga 0.42 

 
Table 3: Biomass expansion factors (BEF) 

 

Temperate Conifers 1.3 

Temperate Broadleaf 1.4 

Boreal Conifers 1.35 

Boreal Broadleaf 1.3 

 
Tree size method (DBH and Height) method 

Above ground carbon stock (living trees) is calculated using the equations developed in Vallet et al. (2006) 
for aboveground tree volume (bole + branches). Above ground tree volume is calculated using tree DBH 
and height values, and volume is converted to dry carbon mass. Above ground dry carbon is calculated as 

 

 
where Vsp (m3) is above ground volume as given by 

 

 
where c130 is the circumference in cm at a height of 130 cm, htot total height in meters and form a unitless 
factor describing a tree’s shape. For Norway Spruce and Douglass fir trees with a c130 > 45, form is calculated 
as 

 

 
and for all other tree species with a c130 > 45 it is calculated as 
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where , , and  are species specific constants (Table 4) and hdn is a measure of a s given 
by: 

 

 
For Douglas fir Beech, Scots pine, and Maritime pine trees with a c130 < 45, form is calculated as 

 

For other species this small tree correction factor is not used. 

 
Table 4: Parameters for tree volume calculations (from Vallet et al., 2006) 

 

Species  
 

 

 
 

 

 

 

Sessile oak 0.471 -0.000345 0.377  

Douglas fir 0.534 -0.000530  56.6 

Norway spruce 0.631 -0.000946   

Common beech 0.395 0.000266 0.421 45.4 

Scot pines 0.297 0.000318 0.384 204.0 

Maritime pines 0.235 0.000970 0.396 198.8 

Silver fir 0.550 -0.000749 0.277  

 
Belowground carbon 

Definition: Dry mass of carbon contained in below ground tree biomass. Units: 

t ha-1. 

 

where R is the root-to-shoot ratio (Table 5). 

Table 5: Root-to-shoot ratios for estimating below ground carbon mass 
 

Forest type Root-to-shoot 

Temperate conifer (above ground biomass <50 t/ha) 0.40 

Temperate conifer (above ground biomass 50-150 t/ha) 0.29 

Temperate conifer (above ground biomass >150 t/ha) 0.20 

Temperate Quercus (above ground biomass >70 t/ha) 0.30 

Temperate broadleaf (above ground biomass <75 t/ha) 0.46 

Temperate broadleaf (above ground biomass 75-150 t/ha) 0.23 

Temperate broadleaf (above ground biomass >150 t/ha) 0.24 

Boreal conifer (above ground biomass <75 t/ha) 0.39 

Boreal conifer (above ground biomass >75 t/ha) 0.24 
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Wood Energy 
For all Wood Energy indices only trees that are larger than 5 cm DBH are considered. 

Above ground wood energy biomass 

Definition: Above ground forest biomass that remains after timber harvest (the latter typically sawn timber 
and pulp wood), i.e., total above ground biomass excluding the extracted part of the tree bole. It is the total 
potentially available biomass in addition to the biomass contained in the marketable bole). 

Units: t ha-1. 

Wood energy biomass (technically harvestable) 

Definition: This is the amount of additional biomasswhich can actually be extracted from the stand. It 
depends mainly on the employed harvesting technology and harvesting system. Practically, it is impossible 
to extract 100% of the potentially available additional biomass in a stand (i.e. small twigs, needles and 
leaves will break off and remain in the stand). 

Units: t ha-1. 

Abovegroundwoodenergybiomassharvest 

Definition: This is the actually extracted amount of additional biomass. It can maximally be as high as Above 
ground wood energy biomass 

Units: t ha-1 

Biodiversity conservation 
The importance of including biodiversity aspects in forest management has been recognised in 
international political processes (Baskent & Keles, 2005; MCPFE, 2003), and management guidelines and 
practices have been defined to better conserve biodiversity in managed forests (through silviculture, timber 
harvesting etc.). For instance, dead tree retention, retention of trees with specific microhabitats (e.g. 
cavities) and tree species mixtures are proposed to improve habitat quality for forest-dwelling species. In 
ARANGE, the aim is to define a set of indices related to biodiversity that will allow partners to assess the 
efficiency of biodiversity conservation for different management scenarios at stand and landscape scales. 
All these indices can be implemented in most models used in ARANGE. When some models are not able to 
implement an index, it is mentioned in the description section. 

Treespeciesdiversity 

Definition: Tree species diversity represents a direct biodiversity index. It is considered as a major feature of 
forest structure (Pommerening, 2002) and may influence forest functioning (see discussion in Nadrowski et 
al., 2010). It also impacts other forest biodiversity components such as floristic diversity. 

Description: A widely used index to assess tree species diversity at stand level is Shannons’s entropy index, H 
(Neuman & Starlinger, 2001), which takes into account the number of species in the stand and their relative 
abundance (by number of trees, basal area, biomass, volume, etc.). Using species-specific basal area, then it 
is defined as follows (living trees with a dbh  5cm): 
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with S the number of species, gi the basal area of species i (m²)and  (m²). Actually, Jost (2006) 

advises the use of the related true diversity index D which is defined as: D =exp(H) 

This index can be interpreted as an “equivalent number of species” as it equals tree species richness when all 
species in the stand/plot share the same abundance. Otherwise, it is always inferior to tree species richness 
(and superior or equal to 1). 

Tree size diversity 

Definition : Tree size diversity is often considered in studies relating stand structure to biodiversity 
(McElhinny et al., 2005). The main idea is that high tree size diversity increases the diversity of habitats for 
forest-dwelling species (Rouvinen & Kuuluvainen, 2005; Buongiorno et al., 1994; Bagnaresi et al., 2002). 

Dead wood abundance 

Definition: Dead wood volume is often considered a good surrogate for the diversity of saproxylic species 
(Martikainen et al., 2000; Grove 2002) as it provides habitats as well as resources for these species (Müller 
& Butler, 2010; Müller et al., 2008). Moreover, it is directly related to tree removal and tree retention 
practices, and as such constitutes a cornerstone to deal with the trade-off between timber production and 
biodiversity conservation. Although a study revealed that the correlation between saproxylic species 
richness and dead wood volume may not be high in temperate forests (Lassauce et al., 2011), probably due 
to a lack of potential species due to strong past human footprint, it is still used in many countries as an 
indirect indicator of biodiversity. 

Description: The dead wood volume DWV (m3ha-1) includes standing dead trees with DBH  5 cm and lying 
dead wood originating from trees with DBH  5 cm whatever the decomposition stage. 

Abundance of large standing deadtrees 

Definition: The total abundance of dead wood is insufficient to assess biodiversity of saproxylic species 
(Lassauce et al., 2011). The diversity of dead wood pieces plays also a role (Müller et al., 2008; Brin et al., 
2009; Simila et al., 2003). Thus, it is important either to consider an index that allow quantifying diversity of 
dead wood pieces (size, the species, position (standing/lying), decomposition stages) or to target a specific 
component of dead wood such as standing dead wood or large woody debris. Standing dead trees (snags) 
contain more microhabitats for saproxilic species than living trees (Vuidot et al., 2011; Fan et al., 2003) and 
provide specific habitats for some species compared to lying dead wood. 

Description: The abundance of large standing dead trees is defined here as the number of trees per hectare 
with a DBH superior or equal to DLSD cm for both conifers and broadleaves. For each tree species there is 
an annual probability for the downing of a dead tree (pd). For instance, in the case of Norway 
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spruce pd=0.103 per year. These probabilities have been derived from literature values by researchers from 
BOKU. Here are the values for the most important species: 

Table 6: Annual probability of dead tree downing for most important species 
 

Norway spruce 
Silver fir European 

larch 

 
European beech 

 
Scots pine 

Sycamore maple 
Common ash 

Birch 

 
Pedunculate oak 

 
Swiss stone pine 

0.103 0.224 0.081 0.142 0.141 0.045 

 
Bird habitat quality indicator 

Bird habitat quality indicator is complementary to previous indices as they target specific species or specific 
group of species. This indicator must be developed with ornithologists/birds experts who are familiar with 
the study area. 

Selecting bird species 

Species listed under the Annex I of Birds Directive (Directive 2009/147/EC) should have a priority when 
searching for possible typical forest bird species. It is recommended to select not individual bird species, 
but a group of species which have various requirements with common elements and an extended 
distribution when examined as a group. 

The group common element could be their nesting method: usualy in tree-holes. The reason for selecting 
this element is that the land use and cover changes due to human actions  the largest hazards for 
forest’sbirds biodiversity and population viability in Europe, especially to species present in old-growth 
forests. Actually, in the last years, the cave-dwelling birds are highly considered as good key species and 
umbrella species for nature conservation and protection. 

The pre-selected group of typical forest bird species (see proposal in Table 7) consists of all the 
woodpeckers potentially present , the Tengmalm's Owl and the Eurasian Tree Creeper. The Tree Creeper is 
much smaller thus less demanding, while it has several similar elements with some woodpeckers. It is also 
highly depended on the tree’s characteristics. 
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Table 7. Proposal of pre-selected bird species. 
 

Bird species Observed 
presence 

Potential 
presence 

Tengmalm's Owl (Aegolius funereus)   

Eurasian Wryneck (Jynx torquilla)   

Grey-headed Woodpecker (Picus canus)   

European Green Woodpecker (Picus viridis)   

Black Woodpecker (Dryocopus martius)   

Great Spotted Woodpecker (Dendrocopos major)   

Syrian Woodpecker (Dendrocopos syriacus)   

Middle Spotted Woodpecker (Dendrocopos medius)   

White-backed Woodpecker (Dendrocopos leucotos)   

Lesser Spotted Woodpecker (Dendrocopos minor)   

Three-toed Woodpecker (Picoides tridactylus)   

Eurasian Treecreeper (Certhia familiaris)   

Other species to be selected with local ornithologists/birds’ 
experts 

  

 
Indicators for habitat quality 

Dead wood, standing: Dying and dead trees have been recognized as a highly important factor for 
breeding and feeding of numerous animal and plant species. Specifically for cave-dwelling birds, the 
standing dead wood has even more significance. Standing deadwood (snags) above specific thresholds (see 
Table 8 below) can be used in accordance with the deadwood indicators (see above). 

Unmanaged forests: This parameter has a similar requirement for nature conservancy as the dead wood. 
Moreover, in the areas where no forest management occurs, the forest ecosystem is closer to natural 
processes, so there is usually a balanced nutrient cycling, dead wood, complex structure, etc. which can 
support high levels of biodiversity. This is a qualitative indicator. 

Veteran trees: There is evidence that the diversity and abundance of animal species are higher around 
veteran trees. The reason is that these trees develop really many micro habitats from the roots to the 
highest branches of the trees. When veteran trees are missing, then these micro-habitats are decreasing. In 
addition, often the veteran trees can be connected with the age of the forest stand. 

Canopy cover: The canopy cover is connected to the general structure of the habitat, hence to the overall 
quality of habitat for birds. Medium cover-range is the most favorable for birds, because these forests have 
the best food availability (insects, good cover of herb- and shrub-layer), while remaining closed enough for 
sheltering and nesting. Too dense and too open cover-range conditions are suboptimal for birds for several 
reasons; mainly because the food availability is reduced. 
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Alien tree species: It’s accepted that mixed forests are better for biodiversity and ecosystem services (more 
available habitats more chances to fulfilling birds’ requirmeents )but this mixture should derive from 
indigenous tree species and not from alien tree species (for which there is no information how they are 
going to affect the forest ecosystems in a long term perspective). 

Defining thresholds for habitat quality indicators 
 

Indicator Good Medium Poor Remarks 

Dead wood, standing 
(m3/ha); for all regions 

excepted Meditteranean one 
> 35 15 - 35 < 15  

Only for standing dead wood, DBH > 
30 cm Dead wood, standing 

(m3/ha); for Mediterranean 
zones 

> 20 10 - 20 < 10 

Unmanaged forest (years) > 100 20 - 100 < 20  

Veteran trees (n/ha) > 20 10 - 20 <10 Maturity of stands, DBH > 50 

 

 
Canopy cover (%) 

 

 
60 - 80 

 

80 - 90 
and 

40 - 60 

 

> 90 

Or 

> 40 

 
Characterizes forest conditions of 
intermediate crown closure; if too 
dense no suitable ground layer will 

develop, if too open no forest 
microclimate will prevail 

Tree species (basal area of 

alien tree species) 
< 10 % > 10 % 

 

 

Protection against natural hazards 
Many mountain forests cover steep to very steep slopes (angle of 35 - 70°) and thus have an important 
protective function against natural hazards such as rockfall, snow avalanches, shallow landslides and 
erosion. The primary function of these protection forests is to protect people or asset from the impact of 
natrual hazards. The “key product” of these forests are the standing trees that act as obstacles to the 
acquisition of the initial conditions necessary to the release of mass movement hazards and/or the 
downslope propagation of these hazards 

By definition, for calculating Protection indices only trees that are larger than 5 cm DBH are considered. 

Protectionagainstrockfalls hazards 

Definition : In the case of rockfall, the forest is efficient only in the transit and deposit zones. There, the 
efficiency of the protection offered by a forest stand against rockfall depends on: 

• The volume, the shape and the mass of the boulder. 

• The initial fall height. 
• The distance between the foot cliff and the entry in the stand.  

• The slope. 

• The slope roughness and the dominant soil type. 

• The length of the forested slope. 
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• The stand dendrometric parameters: stem density, basal area, mean diameter at breast height 
(mean DBH), tree species distribution. (trees >5cm DBH) 

These values need to be collected/calculated at the scale of the versant in order to derive a value of the 
Probable Residual Hazard (PRH). The PRH is equal to the percentage of rocks that are able to pass through 
and exit a forested slope. 

The tool Rockfornet (http://www.ecorisq.org/en/rockfornet.php) calculates this PRH. 

Protection against snow valanches 

Definition: Forests are effective against snow avalanches only in the release zones. The efficiency of the 
protection offered by a forest stand depends on: 

• The mean tree height, which has to be at least equal to twice the maximum snow height. 
• The value of canopy cover in winter. This variable impacts snow interception, its deposition on the 

soil, and the quality (heterogeneity) of the snow cover. 
• The stand dendrometric parameters: stem density, basal area, and mean DBH. The above variables 

have a positive effect on the mechanical anchorage of the snow cover. 
• The slope. 

• The roughness of the forest floor. 
• The size of gaps in the stand: they should not exceed 1.5 times mean tree height in the direct slope 

line. 

The effect of the snow interception on the snow cover stabilization represents 70% of the protection 
provided by a forest stand. The mechanical anchorage represents 30% of the protection effect of a forest 
stand (Berger, 1997). 

As for rockfalls, it is possible to calculate for a given stand an avalanche protection index (API) based on the 
ratio between the current stand parameters and the ones needed for an instantaneous optimal protection. 

For calculating the API the main assumption is that for a given mean DBH the basal area is the dendrometric 
parameter that can be used to synthesize both the interception and the mechanical effects. Knowing the 
basal area needed to avoid a snow avalanche release, it is possible to calculate the API via the ratio (current 
stand basal area / basal area needed). 

Description: The input data for the calculation of the API for one pixel located on a snow avalanche release 
zone (slope of the pixel between 28 and 55° and an elevation superior to 800m) are given in table 10. 

http://www.ecorisq.org/en/rockfornet.php)
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Table 10: input data for the calculation of the API for one site (or pixel if using a GIS) 
 

Forest stand Topography 

Name Abbreviation Units Name Abbreviation Units 

 
Basal area 

 
G 

 
m2/ha 

Slope 

value 

 
slope° 

 
degree 

Average Diameter 

at breast Height 
 

 

 
cm 

 

 
For pure evergreen stands then the formula for calculating the API is: 

 

 
For mixed and pure deciduous (including larch) forests (less than 70% of evergreen stems dbh>5cm) 
the formula for calculating the API is: 

 

 
An API of 1 expresses the fact that the protection is very efficient. 

Protection against landslides and erosion 

Definition: For this category of phenomena and before the results coming from modeling works using 
landslide models able to take into account the role played by stands, we propose to use simple 
recommendations provided by NaiS (Frehner et al. 2005) and the French GSM (Gauquelin & Courbaud 
2006). 

Description: Forests can reduce the likelihood and extent of landslides or erosion by mechanically 
reinforcing the soil through its rooting system, and can positively influence the water balance in the soil 
through interception, transpiration and enhanced soil permeability (Frehner et al. 2005). Well-developed 
forests that are multi-layered provide the greatest protection from both landslides and erosion. The 
assumption being that a well-structured above ground forest will have a corresponding well-structured and 
extensive rooting system that will minimize landslide potential. 

Guidelines suggest that in areas where landslides may originate that the minimum profile is a forest that is 
multi-layered and has canopy coverage  30%-40% canopy coverage. The ideal profile is a multi-layered 
forest with  60% canopy coverage. 
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Landslide Protection Index (LPI) is qualified by using forest cover (% projected canopy cover area: cannot be 
superior to 100% ; all trees with a dbh  5cm) only as clear thresholds for stand stratification are not 
available: 

• Forest cover < 30% : LPI=low 

• Forest cover  30% and <60% : LPI=medium 

• Forest cover  60% : LPI=high 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 


